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Introduction

Welcome to Adobe Flash CS4 Professional On Demand, a
visual quick reference book that shows you how to work 
efficiently with Flash.  This book provides complete coverage
of basic to advanced Flash skills.

How This Book Works
You don’t have to read this book in any particular order.
We’ve designed the book so that you can jump in, get the
information you need, and jump out. However, the book does
follow a logical progression from simple tasks to more com-
plex ones. Each task is presented on no more than two facing
pages, which lets you focus on a single task without having
to turn the page. To find the information that you need, just
look up the task in the table of contents or index, and turn to
the page listed. Read the task introduction, follow the step-
by-step instructions in the left column along with screen illus-
trations in the right column, and you’re done.

What’s New
If you’re searching for what’s new in Flash CS4, just look for
the icon: New!. The new icon appears in the table of contents
and throughout this book so you can quickly and easily iden-
tify a new or improved feature in Flash. A complete descrip-
tion of each new feature appears in the New Features guide
in the back of this book.

Keyboard Shortcuts
Most menu commands have a keyboard equivalent, such as
Ctrl+P (Win) or A+P (Mac), as a quicker alternative to using
the mouse. A complete list of keyboard shortcuts is available
on the Web at www.perspection.com.

How You’ll Learn

How This Book Works

What’s New

Keyboard Shortcuts

Step-by-Step Instructions

Real World Examples

Workshops

Adobe Certified Expert

Get More on the Web
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Step-by-Step
Instructions
This book provides concise step-
by-step instructions that show you
“how” to accomplish a task. Each
set of instructions includes illus-
trations that directly correspond to
the easy-to-read steps. Also
included in the text are time-
savers, tables, and sidebars to
help you work more efficiently or
to teach you more in-depth infor-
mation. A “Did You Know?” pro-
vides tips and techniques to help
you work smarter, while a “See
Also” leads you to other parts of
the book containing related infor-
mation about the task. 

Real World Examples
This book uses real world exam-
ple files to give you a context in
which to use the task. By using
the example files, you won’t waste
time looking for or creating sam-
ple files. You get a start file and a
result file, so you can compare
your work. Not every topic needs
an example file, such as changing
options, so we provide a complete
list of the example files used
throughout the book. The example
files that you need for project
tasks along with a complete file
list are available on the Web at
www.perspection.com.

Real world
examples help
you apply what
you’ve learned
to other tasks.

Illustrations
match the
numbered
steps.

Numbered
steps guide
you through
each task.

Did You Know? alerts
you to tips, techniques
and related information.

See Also points you to
related information in
the book.

Easy-to-follow
introductions
focus on a
single concept.
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The Workshop
walks you
through in-depth
projects to help
you put Flash 
to work.

Introduction xix

Workshops
This book shows you how to put
together the individual step-by-
step tasks into in-depth projects
with the Workshop. You start each
project with a sample file, work
through the steps, and then com-
pare your results with a project
results file at the end. The Work-
shop projects and associated files
are available on the Web at
www.perspection.com.

Adobe Certified Expert
This book prepares you fully for
the Adobe Certified Expert (ACE)
exam for Adobe Flash CS4. Each
Adobe Certified Expert certifica-
tion level has a set of objectives,
which are organized into broader
skill sets. To prepare for the certifi-
cation exam, you should review
and perform each task identified
with a Adobe Certified Expert
objective to confirm that you can
meet the requirements for the
exam. The Adobe Certified Expert
objectives are available on the
Web at www.perspection.com.

Logo indicates a
task fulfills one or
more Adobe
Certified Expert
objectives.
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Get More on the Web
In addition to the information in
this book, you can also get more
information on the Web to help
you get up-to-speed faster with
Flash CS4. Some of the informa-
tion includes: 

Transition Helpers
◆ OOnnllyy  NNeeww  FFeeaattuurreess..

Download and print the new
feature tasks as a quick and
easy guide.

Productivity Tools
◆ KKeeyybbooaarrdd  SShhoorrttccuuttss..

Download a list of keyboard
shortcuts to learn faster ways
to get the job done. 

More Content
◆ PPhhoottooggrraapphhss.. Download

photographs and other
graphics to use in your Flash
documents. 

◆ MMoorree  CCoonntteenntt.. Download
new content developed after
publication.

You can access these additional
resources on the Web at
www.perspection.com.

Additional
content 
is available
on the Web. 

Additional
content 
is available
on the Web. 

A03FLCS4.qxp  10/15/2008  12:27 PM  Page xx



Creating Graphics

Introduction

Flash offers a full suite of tools for creating and editing
graphics. When you draw in Flash, you create vector art.
VVeeccttoorrss are mathematical descriptions of lines and points
that, when connected, form shapes and objects. Vector-
defined art is not limited by resolution like bitmaps are, so
they can be scaled to any size without a loss in quality or
increase in file size. This is the basis of Flash; and the main
reason Flash files are so small and why they can be deployed
on so many platforms. Vector graphics are also fully editable
after they are created so you can continue to adjust their
properties. Included in Flash are many of the drawing tools
and procedures familiar to the seasoned user of vector draw-
ing programs. It is also a good place for the beginner to
learn. Sketch naturally with the Pencil and Brush tools or use
vector-based objects, such as the Rectangle or Oval tools or
the Polystar tool. Use the Pen tool to create lines and shapes
with Bézier curves. Whatever is drawn can be edited and
modified with a variety of tools and palettes. When you select
an object or graphic on the Stage, the Property Inspector dis-
plays the attributes of that object that are modifiable, such as
fill and stroke color, position, and scale. 

You can draw shapes in Flash using two drawing models:
Merge Drawing and Object Drawing. The MMeerrggee  DDrraawwiinngg
model, the default (like previous versions of Flash), automati-
cally merges shapes that you draw when you overlap them.
If you select a shape that has been merged with another, and
move it, the shape below it is moved too. The OObbjjeecctt  DDrraawwiinngg
model allows you to draw shapes as separate objects that do
not automatically merge together when you overlap them.
You can now extend the Object Drawing mode by creating
primitive rectangles and ovals in PPrriimmiittiivvee  mmooddee, which
allows you to edit properties in the Property Inspector and
specify the corner radius of rectangles and inner radius of
ovals. This makes it easy to create pie wedges, round off cor-
ners, and other curved shapes.

3

3
What You’ll Do

Work with Object Drawing

Draw Lines and Shapes

Use the Selection Tools

Zoom In and Out

Move Around with the Hand Tool

Use Rulers, Grids, and Guides

Modify Grid and Guide Settings

Use Snap Align

Change Stroke and Fill Colors

Create Custom Colors

Add Colors Using the Kuler Panel

Edit Strokes with the Ink Bottle

Edit Fills with the Paint Bucket

Use the Spray Brush and Deco Tools

Edit Strokes and Fills with the 
Eyedropper

Create Gradients

Use the Fill Lock

Use Paint Brush Modes

Draw with the Pen Tool

Modify Shapes

Use the Free Transform Tool

Use Transform Options for Shapes

Change Drawing Settings

73
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Working With Object
Drawing

Enable and Use Object Drawing

Select a drawing tool on the Tools
panel that supports Object
Drawing (Pencil, Line, Pen, Brush,
Oval, Rectangle, and Polygon). 

Select the Object Drawing button
on the Tools panel.

TIMESAVER Press the J key to
toggle between Merge and Object
Drawing.

With the Pointer tool, click to
select an object, and then drag the
bounding box to move it.

To switch back Merge Drawing,
click the Object Drawing button
again. 

4

3

2

1

Previously in Flash, all shapes in the same layer on the Stage could
change other overlapping shapes, known as Merge Drawing. In Flash,
you can create shapes directly on the Stage that do not affect other
overlapping shapes, known as Object Drawing. By default, Flash uses
Merge Drawing. To draw shapes using Object Drawing, you use the
Object Drawing button on the Tools panel. When you select a shape
created using Object Drawing, Flash selects the shape with a rectangu-
lar bounding box, which you can use with the Pointer tool to move the
shape on the Stage. You can use General preferences to set selection
options for contact-sensitivity when selecting shapes created using
Object Drawing.

1

2

Bounding box

Objects created
with Object Drawing

3

See Also
See “Setting General Preferences” on
page 60 for information on options for
contact-sensitivity when selecting
shapes created using Object Drawing.

Did You Know?
You can convert a Merge Drawing
shape to an Object Drawing shape.
Select the shape on the Stage, click
the Modify menu, point to Combine
Object, and then click Union. 
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Chapter 3 Creating Graphics 75

Drawing with the 
Line Tool

Use the Line Tool

Click the Line tool on the Tools
panel. 

The pointer becomes a crosshair
that you can drag on the Stage.

TIMESAVER Press N to select
the Line tool.

Click and drag on the Stage, and
then release the mouse when the
line is the length you need. 

TIMESAVER Hold down the
Shift key, and then drag to draw a
45, 90, or 180 degree line. 

To change line properties, click to
select the stroke, and then specify
the options (Color, Weight (0-200),
Style, Width and Height, Cap, Join,
or Miter) you want in the Property
Inspector.

TROUBLE? To display the
Property Inspector, click the
Window menu, point to Properties,
and then click Properties. 

3

2

1

The Line tool draws perfectly straight lines in any direction you drag
your mouse. In Flash, a line is called a stroke and there is a variety of
thicknesses (0-200 pixels), styles, colors, and gradient fills that can be
applied to it. You can also create your own line style for specific types
of dashed, dotted or artistic lines. You can constrain the path a line
draws to 45-degree angles or create closed shapes by intersecting the
lines you draw. In Merge Drawing when a line overlaps another line on
the same layer, it essentially cuts it into two pieces that can be edited
as separate objects. You can also specify a line cap and join type. A
join is the place where two strokes meet (Miter, Round, or Bevel). A
cap is the end point of a stroke that does not join with another stroke.
Select Stroke hinting to make stroke intersections easier to view. 

2

1

Cap and Join
options

A preview of the line appears as you
drag. A circle beneath the crosshair
indicates the line's endpoint. 

Stroke join

See Also
See “Changing Stroke and Fill Colors”
on page 96 for information on using
color.

Stroke width
and height

Fill Color

Stroke Scale
and Hinting

Stroke Weight
and Style

Stroke Color

3
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Drawing with the
Pencil Tool

Use the Pencil Tool in 
Straighten Mode

Click the Pencil tool on the Tools
panel.  

The pointer becomes a pencil. The
Pencil tool options appear at the
bottom of the Tools panel. The
default mode is Straighten.

TIMESAVER Press Y to select
the Pencil tool.

Draw on the Stage with the Pencil,
and then release the mouse. 

A rough preview of the line
appears as you draw. In Straighten
mode, Flash transforms the line
into a series of straight-line
segments and standard curves.

To change the straighten rate
(New!), select the object, click
the Modify menu, point to Shape,
click Straighten, enter a value, and
then click OK.  

3

2

1

Use the Pencil tool for freeform drawing. When you draw with the
Pencil tool you are creating strokes. It works the same way as a real
pencil with options for smoothing and straightening. Depending upon
which mode you choose, Flash makes corrections to the drawn line.
Smooth mode softens the curve of the line you draw while Straighten
mode transforms the line into a series of straight-line segments and
standard curves. If you are using the Pencil or Brush tools with Smooth
mode, you can specify the degree of smoothness. Additionally, Flash
performs shape recognition to the lines you draw so that if it detects
something approximating a simple geometric shape such as a rectan-
gle, oval, or triangle, it converts your drawing into whichever shape it
detects. To bypass these modifications, select Ink mode. This mode
allows for the most freeform drawing with minimal correction by Flash.

Pencil mode is set to
straighten by default.

Flash straightens
the drawn line.

Flash applies shape recognition
in Straighten mode. 

2

Did You Know?
Flash converts rough shapes into
clean, geometric shapes. Set the toler-
ance level of shape recognition in the
Drawing preferences. 

1

FL 2.2
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Chapter 3 Creating Graphics 77

Use the Pencil Tool in 
Smooth Mode

Click the Pencil tool on the Tools
panel.   

The pointer becomes a pencil. The
Pencil tool options appear at the
bottom of the Tools panel. 

Click the Pencil mode popup in the
Options area of the Tools panel,
and then click Smooth.

In the Property Inspector, click the
Smoothing popup, and then click a
value from 1 to 100. 

The default value is set to 50. The
greater the smoothing value, the
smoother the resulting line. 

TROUBLE? To display the
Property Inspector, click the
Window menu, point to Properties,
and then click Properties. 

Draw on the Stage with the Pencil,
and then release the mouse.  

A rough preview of the line
appears as you draw. In Smooth
mode, Flash smoothes the line you
draw into curved line segments.

To change the smooth rate and
angles (above and below) (New!),
select the object, click the Modify
menu, point to Shape, click
Smooth, enter a value, and then
click OK.

5

4

3

2

1

4 Flash smoothes
the drawn line.

Use Ink mode for more
freeform drawing.

Did You Know?
You can disable straightening and
smoothing. Click the Pencil mode
popup in the Options area of the Tools
panel, and then click Ink mode to yield
a line closest to the line you've drawn
with minimal corrections 
performed by Flash.

Smoothing Curves Another Way
You can also smooth curves by optimizing the shape. Optimizing a
shape refines curved lines and fill outlines by reducing the number
of curves used to define the shape. To optimize a shape, click it, click
the Modify menu, point to Shape, click Optimize, specify a smoothing
level, select additional options (select Use Multiple Passes to repeat
the smoothing process until you can’t anymore, and select Show
Totals Message to display an alert when smoothing is complete), and
then click OK.

For Your Information

1

3

2

5

Select to display a live preview of
your changes
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Drawing Shapes with
the Rectangle and
Oval Tools

Draw with the Oval Tool 

Click the Oval or Oval Primitive
tool on the Tools panel. 

TIMESAVER Press O to select
an Oval tool.

Select a Stroke and Fill Color from
the Colors area of the Tools panel.

Click and drag on the Stage, and
then release the mouse. 

TIMESAVER Press and hold
Shift while you drag to create a
circle.

In the Properties Inspector,
change the values you want. 

Draw with the Rectangle Tool 

Click the Rectangle or Rectangle
Primitive tool on the Tools panel. 

TIMESAVER Press R to select
a Rectangle tool.

Select a Stroke and Fill color from
the Colors area of the Tools panel. 

Click and drag on the Stage, and
then release the mouse. 

TIMESAVER Press and hold
Shift while you drag to create a
square.

In the Properties Inspector,
change the values you want. 

4

3

2

1

4

3

2

1

The Flash Tools panel includes several tools for quickly creating simple
geometric vector shapes. They are easy to use; you just click and drag
on the Stage to create the shapes. The Rectangle tool creates rectan-
gles with square or rounded corners. The Oval tool creates circular
shapes such as ovals and circles. These shapes can be comprised of
Strokes, which are lines that surround and define the shape, Fills, which
are a color or texture inside the shape, or both. You can create two
types of shapes: Drawing or Primitive. Drawing, or standard, shapes are
self contained; the stroke and fill of a shape are not separate elements,
while for Primitive shapes they are separate elements. 

3

1

2

3

1

2

FL 2.2
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Chapter 3 Creating Graphics 79

Draw a Rounded Rectangle

Click the Rectangle or Rectangle
Primitive tool on the Tools panel. 

Enter a value for the corner radius
in the Properties Inspector. 

To create an exact size rectangle
shape, select the shape, enter the
width and height values in the
Properties Inspector. 

Click and drag on the Stage, and
then release the mouse. 

4

3

2

1
5 points 20 points 35 points

Did You Know?
You can enter values ranging from 0 to
100 points in the Rectangle Settings
dialog box. A value of zero gives you a
straight-sided-square. Higher numbers
produce squares with more rounded
sides.

You can hold down the Shift key while
dragging to produce a perfect square
with equal sides or a perfect circle. If
you want to draw an oval or a rectan-
gle without a stroke or fill, you can set
either of these options to No Fill in the
Colors area of the Tools panel or in the
Color Mixer.

You can draw shapes without a stroke
or a fill. Set either of these properties
to No Fill in the Colors section of the
Tools panel or in the Color Mixer.

You can set specific sizes with a dia-
log box. Alt+click (Win) or Option+click
(Mac) a rectangle or oval, set the val-
ues you want, and then click OK. 

See Also
See “Changing Stroke and Fill Colors”
on page 96 for information on changing
shapes.

Creating Primitive Rectangles and Ovals
In addition to creating standard rectangles and ovals, you can now
create Primitive rectangles and ovals. A Primitive shape allows you
to change its attributes in the Property Inspector. The Primitive
shape tools allow you to specify the corner radius of rectangles, and
the start and end angle and the inner radius of ovals using controls
in the Property Inspector, which makes it easy to create pie wedges,
rounded corners, and other curved shapes. When either of the
Primitive shape tools is selected, the Property Inspector retains the
values of the last primitive object that you edited.

For Your Information

24

1

3
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Using the Polystar 
Tool

Draw a Polygon or Star Shape

Click and hold the Rectangle tool
on the Tools panel, and then point
to  PolyStar Tool. 

The pointer becomes a crosshair
that you can drag anywhere on the
Stage.

Click Options in the Property
Inspector. 

TIMESAVER Press A+F3
(Mac) or Ctrl+3 (Win) to open the
Property Inspector.

Click the Style popup, and then
select Polygon or Star.

Enter a value for the number of
sides. You can create an object
with up to 32 sides.

For the Star style, you can specify
an additional option for your point
size. You can enter a value ranging
from .10 to 1.0 points.

Click OK.

Click and drag on the Stage, and
then release the mouse. 

7

6

5

4

3

2

1

Working in much the same way as the Oval and Rectangle tools, the
new Polystar tool allows you to easily create complex vector shapes.
You can use this tool to create polygons and stars with up to 32 sides.
Choose between creating a polygon or a star. Both styles have charac-
teristics that can be adjusted in the Property Inspector before you draw
the shape. Both the polygon and star style can have up to 32 sides, with
the star style having an additional star point size that can be set.
Experiment with several options to get the kind of shape you want.

5

4

3

1

6See Also
See “Editing Strokes with the Ink
Bottle” on page 102 for information on
editing an object. 

7 Polystar shape

2

FL 2.2
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Chapter 3 Creating Graphics 81

When you create vector graphics in Flash,
they are comprised of distinct elements that
can be selected separately or as a whole with
a variety of selection tools. The type of editing
you need to perform determines which tool
you use. For example, a simple rectangle
drawn is comprised of four line segments that
surround the contour of the shape and one fill
in the center. Each of these five parts can be
selected in tandem or individually with the
Selection tool. Likewise, any stroke that inter-
sects another stroke or fill splits them into dis-
tinct elements that can be selected separately. 

In Normal selection mode, holding down
the Shift key adds to the selection any addi-
tional elements you click on. You can change
this option in the General tab of the
Preferences window so that it isn't necessary
to use the Shift key to perform this function.
Double-click any stroke to select other strokes

connected to it or double-click a fill to select it
and any strokes that touch or intersect it. To
select an entire shape (strokes and fills) or
just a portion of it, you can drag a selection
rectangle with the Selection tool or draw a
freeform selection area with the Lasso tool.
These methods work best for very complex
shapes with many intersecting strokes and
fills, or if there is only a portion of the shape
you need to edit.

The Sub-Selection and Pen tools allow you
to select the entire shape (strokes and fills)
simultaneously, making its anchor points and
Bézier handles visible for editing. Use this
method when you need to edit the contours
of the shape with precision.

For information on making selections
using the Object Drawing model, see
“Working with Object Drawing”, on page 74.

Understanding Selections

Each element (4
lines and a fill) can
be selected
separately.

Shift-select to
add elements to

the selection.

Single line segment. When two line segments
intersect, four new line

segments are created that
can be selected

separately.

Double-click a fill
to select it and any
connected strokes.

Double-click a
stroke to select all

connected
strokes.

Click and drag to
select a portion of
the shape.

Only a portion of
the fill and strokes
is selected.

Selection Examples
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Selecting Strokes 
with the Selection 
Tool

Select a Stroke with the
Selection Tool 

Click the Selection tool on the
Tools panel. 

The pointer becomes an arrow.

TIMESAVER Press V to select
the Selection tool.

Position the arrow on the edge of
the shape. 

Notice that Flash displays a small
curved line icon when you position
the arrow over a Curve point and a
corner line icon when over a
Corner point.

Click on any part of the stroke. 

Flash only selects a portion of it.
This is because what appears to
be one whole shape is actually a
series of lines connected by points
and each can be selected
separately.  

3

2

1

There are several ways to select objects in Flash. You can select an
object's stroke or fill or both. You can use the Selection tool to select
parts of the object or drag over a portion of it to create a selection rec-
tangle. The Property Inspector displays the properties of what is
selected including Stroke line weight and style, Fill color, pixel dimen-
sions, and X and Y coordinates. When a stroke or fill is selected, a dot-
ted pattern appears over it indicating it has been selected. This makes
editing and modifying graphics simple and illustrates the versatility of
the vector-based graphics model used in Flash.

2 Curve point detected

Corner point detected 

See Also
See “Working with Object Drawing” on
page 74 for information on selecting
overlapping objects on the same layer.

3

1
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Select Multiple Stroke
Segments 

Click the Selection tool on the
Tools panel.

The pointer becomes an arrow. 

TIMESAVER Press V to select
the Selection tool. You can
temporarily switch to the Selection
tool from any other tool by
pressing A (Mac) or Ctrl (Win).

Click on any part of the stroke to
select one segment.

Hold down the Shift key, and then
click other strokes to add them to
the selection.

Select Connected Stroke
Segments

Click the Selection tool on the
Tools panel. 

The pointer becomes an arrow.

Double-click any part of the
segment or stroke to select all
connected strokes.

2

1

3

2

1

32

1

Shift-select to add stroke segments 
to the selection.

2 All connected stroke segments selected.

Did You Know?
You can turn off the Shift-select 
feature in the General tab of the
Preferences dialog box. When this
feature is disabled, you can add to the
selected segments by clicking them
without the need to hold down the Shift
key. In this mode, holding the Shift key
and clicking a selected stroke segment
deselects that segment.

1

C03FLCS4.qxp  10/16/2008  1:10 AM  Page 83



84

Selecting Strokes 
and Fills with the
Selection Tool

Select Fills with the Selection
Tool 

Click the Selection tool on the
Tools panel. 

The pointer becomes an arrow.

Position the arrow in the Fill area
or the center of the shape and
click.

The fill becomes highlighted with a
dotted pattern to indicate it has
been selected. Hold down the Shift
key to add other strokes and fills to
the selection.

Select with a Selection
Rectangle  

Click the Selection tool on the
Tools panel. 

The pointer becomes an arrow.

Click on the Stage above and to
the left of the shape you want to
select and drag to create a
Selection Rectangle, and then
release the mouse when the
bounding box fully encloses the
shape.

2

1

2

1

The Selection tool provides the most simple and versatile procedures
for selecting objects in Flash. The Selection tool selects anything you
click on (provided it isn't on a locked layer). Double-clicking shapes
with the Selection tool selects all fills and strokes that are connected.
Shift-selecting allows you to add to the selection only what you need.
Alternately, dragging a selection rectangle on the Stage with the
Selection tool creates a bounding box that selects anything you drag it
over. This bounding box method is the most reliable technique for
selecting very complex objects with many intersecting strokes and fills.

Selected fill

Double-clicking
the shape selects
both the fill and
the stroke.

Both fill and strokes are selected.

1

2

2

1
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Making Selections
with the Lasso Tool

Select with the Lasso Tool

Click the Lasso tool on the Tools
panel. 

TIMESAVER Press L to select
the Lasso tool.

Draw around the shapes you want
to select. 

To complete the selection, return
to the point where you started.  

Select with the Lasso Tool in
Polygon Mode 

Click the Lasso tool on the Tools
panel. 

Click the Polygon Mode button in
the Options area of the Tools
panel.

Click near the area you want to
select. Move the pointer and click
again. Keep clicking until the
object or portion you want to
select is surrounded.

Double-click to complete the
selection.

4

3

2

1

3

2

1

Use the Lasso tool when you want to select shapes that are too close
to shapes you don't want to select. This tool allows you to draw around
the shape, selecting everything contained in the shape you draw. In the
default mode, you can draw a freeform lasso around the object you
want to select. You can also choose the Polygon mode for defining the
selected area with a series of straight-line segments.

Selected shape

Selected shape2

1

Did You Know?
You can select single or multiple
objects. Holding the Shift key adds line
segments and fills them. Shift-clicking
selected items deselects them. 

1

2

3

Flash draws a preview of the
selection lasso as you draw.
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Zooming In and Out
with the Magnifying
Glass

Zoom In 

Click the Zoom tool on the Tools
panel.   

Click the Enlarge button in the
Options area of the Tools panel. 

The pointer becomes a magnifying
glass with a plus (+) symbol in it.

Click on the area of the Stage you
want to zoom into.

TIMESAVER Press Z to select
the Zoom tool. To temporarily
toggle between the Enlarge and
Reduce Modifiers buttons in the
Options area of the Tools panel,
press Option (Mac) or Alt (Win).

Zoom Out 

Click the Zoom tool on the Tools
panel.  

Click the Reduce button in the
Options area of the Tools panel. 

The pointer becomes a magnifying
glass with a minus (-) symbol in it.

Click on the area of the Stage you
want to zoom out from.

3

2

1

3

2

1

Because the Stage and Work Area in Flash share the same space with
a variety of panels, palettes and windows, it is often necessary to
change the magnification level. You can use the Magnifying Glass to
zoom out and see the entire piece or zoom in to do more detailed work
on a small portion. The tool is made up of two modifiers: a plus (+) sym-
bol in the circle indicates enlargement of the Stage and a minus (-) indi-
cates reduction. Flash allows magnification levels from 8 percent to
2000 percent. 

3

3

1

2

2

1
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Zoom Into a Specific Area by
Dragging on the Stage

Click the Zoom tool on the Tools
panel. 

Click the Reduce or Enlarge button
in the Options area of the Tools
panel. 

Click on the area of the Stage you
want to magnify and drag the
pointer. 

3

2

1

3

Did You Know?
You can change the magnification
level in several places. The Zoom
Control field in the top right hand cor-
ner of the Stage allows you to enter a
value or access a popup with various
magnification levels. You can also
change the magnification submenu in
the View menu or use the keyboard
shortcuts A+ - (Mac) or Ctrl+ - (Win)
to zoom out, and A+ + (Mac) or 
Ctrl+ + (Win) to zoom in. Quickly switch
to 100 percent magnification by press-
ing A+1 (Mac) or Ctrl+1 (Win). 

2

1
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Moving Around with
the Hand Tool

Move the Stage View

Click the Hand tool on the Tools
panel. 

The pointer becomes a small hand
that moves the entire Stage
revealing other parts of the Stage
as you drag.

TIMESAVER Pressing the
space bar temporarily changes the
active tool to the Hand tool.
Continue holding as you drag.

Click and drag the Stage to move
the view. 

2

1

At certain magnifications, parts of the Stage may not be viewable. Use
the Hand tool to quickly move to different parts of the Stage without
having to change the magnification level. The Stage is the active area
of your movie, the only area that will be visible in the exported Flash
movie. The gray area around the Stage is the Work Area. The Hand tool
allows you to easily access artwork or other objects contained in this
space if you are doing detailed work at high levels of magnification. 

2

Did You Know?
You can turn off the visibility of the
Work Area (the gray space around the
Stage) and quickly change the View
scale to 100 percent. Toggle the Work
Area option in the View menu or use
the keyboard shortcut A+Shift+W
(Mac) or Ctrl+Shift+W (Win). This is a
great way to temporarily see what is
viewable in the exported Flash file
(SWF) when you are working with
large images that extend past the
Stage boundaries.

Using the Pasteboard Work Area
You can use the work area (called the Pasteboard) around the Stage
to store artwork and other objects, such as components, without
having them be visible in the published movie. The objects might not
be visible on the Stage, but they contribute to the overall file size. It
is a good idea to clean up your files before exporting the final movie.
You can clean up by removing any artwork outside the boundaries of
the Stage or by putting them on a guide layer. 

For Your Information

1
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Displaying Rulers

Show and Hide Rulers 

Click the View menu, and then
click Rulers. 

A check mark next to the option
means its visibility is enabled.

To hide rulers, click the View
menu, and then click Rulers to
remove the check mark and hide
the rulers. 

TIMESAVER Press
A+Option+Shift+R (Mac) or
Ctrl+Alt+Shift+R (Win) to turn 
the ruler on and off.

2

1

Ruler bars are located on the top and left sides of the Stage and serve
several purposes. They let you measure the width and height of Flash
elements and they let you place guides on the screen to control place-
ment of objects on the Stage. In all, Rulers serve a very important role.
When you display rulers, you can use guides to help you correctly align
objects with other objects. By using guides, you have access to precise
alignment systems. To use the guides, the ruler bars must first be visi-
ble. When you no longer need the rulers, you can hide the rulers to free
up more workspace.

1

Vertical ruler

Horizontal ruler

Did You Know?
You can change the unit of measure
displayed on the Rulers. Click the
Modify menu, click Document, click the
Ruler Units popup, select a unit of
measure, and then click OK. 
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Using Grids and
Guides

Show and Hide Grids 

Click the View menu, point to Grid,
and then click Show Grid.  

◆ You can also right-click (Win)
or control-click (Mac) the
Stage, point to Grid, and then
click Show Grid. 

A check mark next to the option
means its visibility is enabled.

To hide the grid, click the View
menu, point to Grid, and then click
Show Grid to remove the check
mark and hide the grid.

TIMESAVER Press
A+apostrophe (') (Mac) or
Ctrl+apostrophe (') (Win) to toggle
Grid visibility on and off.

2

1

Flash comes with guides, grids, and rulers to help you lay out artwork
and objects with precision. A grid is a series of crisscrossed lines that
aid in aligning objects to each other on the Stage. Guides and grids are
modifiable. You can change their visibility, position, color, and fre-
quency. These items are invisible by default, but they can be easily
turned on and adjusted. Though you see them in the Flash development
environment, they are invisible on export. Use guides to align art and
objects to each other on vertical or horizontal paths, or turn on the grid
for use in designing a layout that is proportional and balanced. 

1 Grid when visible

See Also
See “Modifying Grid and Guide
Settings” on page 92 for information on
changing settings.
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Create Guides

Click the View menu, and then
click Rulers to display rulers. 

Click on the vertical ruler on the
left side of the work area with the
Arrow pointer and drag to the
right, and then release the mouse
where you want to place the
vertical guide. 

A small directional triangle and
line appears next to the pointer as
you drag indicating that you are
dragging the guide.

Click on the horizontal ruler at the
top of the work area with the
Arrow pointer and drag down, and
then release the mouse where you
want to place the horizontal guide.

Reposition the guides by selecting
them with the pointer.

4

3

2

1
1

Did You Know?
You can turn guide visibility on and
off, lock guides, and enable or disable
snapping to guides. Click the View
menu, and then click Guides to access
these options or use the following 
keyboard shortcuts: A+; (Mac) or
Ctrl+; (Win) toggles between showing
and hiding guides. Option+A+; (Mac)
or Ctrl+Alt+; (Win) locks and unlocks
guides. Shift+A+; (Mac) or Ctrl+
Shift+; (Win) turns Snapping on and off.

See Also
See “Displaying Rulers” on page 89 for
information on showing and hiding
rulers.

2

3
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Modifying Grid and
Guide Settings

Modify Grid

Click the View menu, point to Grid,
and then click Edit Grid.  

TIMESAVER Press
Option+A+G (Mac) or Ctrl+Alt+G
(Win) to quickly access the Grid
dialog box.

Click the Color popup, and then
click a grid line color.

Select or clear the Show Grid
check box to show or hide the
grid.

Select or clear the Show Over
Objects check box (New!) to
show or hide the grid over objects.

Select or clear the Snap To Grid
check box to enable or disable
snapping.

Enter values for horizontal and
vertical dimensions for the grid
lines.

Click the Snap Accuracy popup,
and then select a level of
sensitivity for snapping to the grid.
Select from Must Be Close,
Normal, Can Be Distant, and
Always Snap.

To make the current grid settings
the default for new Flash files,
click the Save Default button.

Click OK.9

8

7

6

5

4

3

2

1

The need for grids and guides varies depending upon the type of docu-
ment you are working on. They are useful for aligning text and graphics
to interface elements and are an invaluable tool for creating a well 
composed and proportioned layout. Every project is different and has
different requirements, so Flash allows the display, behavior, and char-
acteristics of guides and grids to be altered to fit your needs. They are
only visible in the Flash development environment, and are not exported
in the Flash movie.

7

2 35 4

9

8

6
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Modify Guides

Click the View menu, point to
Guides, and then click Edit Guides.

TIMESAVER Press
Option+Shift+A+G (Mac) or
Ctrl+Alt+Shift+G (Win) to quickly
access the Guides dialog box.

Click the Color popup, and then
click a guide line color. 

Select or clear the Show Guides
check box to show or hide guides.

Select or clear the Snap To Guides
check box to enable or disable
snapping.

Select or clear the Lock Guides
check box to enable or disable
movement of guides.

Click the Snap Accuracy popup,
and then select a level of
sensitivity for snapping to the
guides. Select from Must Be
Close, Normal, Can Be Distant.

To remove all guides from the
active scene, click Clear All.

To make the current guides the
default guides for new Flash files,
click Save Default.

Click OK.

TIMESAVER Press A+; (Mac)
or Ctrl+; (Win) to toggle between
showing and hiding guides; press
Option+A+; (Mac) or Ctrl+Alt+;
(Win) to lock and unlock guides; or
press Shift+A+; (Mac) or
Ctrl+Shift+; (Win) to turn Snapping
on and off.

9

8

7

6

5

4

3

2

1

6

2 3 4 5

9

7

8
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Using Snap Align

Enable Snap Align

Click the View menu, point to
Snapping, and then click 
Snap Align. 

A check mark appears next to the
menu item when Snap Align is
enabled.

Drag an object on the Stage.

Depending on the behaviors set in
the Snap Align Settings dialog box,
gray dashed lines appear when
the edges or center vertices of
objects move to within a certain
pixel distance.

2

1

Snap Align is a new feature that enables dynamic alignment of art and
objects on the Stage. Simply drag an object on the Stage and dashed
lines appear that aid you in aligning to the edge or center vertices of
other objects on the Stage. In the Edit Snapping dialog box you can
enable and disable snap options, set the distance objects are to be
from the movie borders and from each other before they snap, and
save the settings as default. Additionally, you can choose to snap
objects to edges or vertical and horizontal centers. Using the Snap
Align feature enables you to lay out artwork more precisely and 
dynamically.

1

Edge Align Edge Align

Center Align
Horizontal

Center Align
Vertical

Snap Align to other
items: Grid, Guides,
Pixels, and Objects.

Did You Know?
You can change snapping tolerances.
Click the Flash (Mac) or Edit (Win)
menu, and then click Preferences.
Click the Drawing category, use the
Connect Line popup to select an
option, and then click OK. 
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Configure Snap Align and 
Save Defaults

Click the View menu, point to
Snapping, and then click Edit
Snapping. 

Select the snap check box options
you want to turn on.

Click Advanced.

Select from the following options:

◆ Snap align settings. Enter a
value for the distance an object
needs to be before it will snap
to the boundaries of the stage
movie (in pixels).

◆ Object spacing. Enter a value
for horizontal and vertical edge
tolerance (in pixels).

◆ Center alignment. Select the
check boxes to center
alignment on horizontal or
vertical vertices or both.

To make the snap align setting the
default for future use, click Save
Default.

Click OK.6

5

4

3

2

1

4

5

6

32

Snapping to an Object
You can use the Snap to Object command in the View menu or use
the Snap option for the Selection tool on the Tools panel. If the Snap
option is enabled, a small black ring appears under the pointer when
you drag an object. The small ring changes to a larger ring when the
object is within snapping distance of another object.

For Your Information
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Changing Stroke and
Fill Colors

Change the Stroke Color

Click the Selection tool on the
Tools panel. 

Select the stroke of the shape by
double-clicking it. 

Click the Stroke color box on the
Tools panel or Property Inspector. 

Select a new color from the
palette.

4

3

2

1

Artwork created in Flash can have strokes and fills. Strokes and fills
behave differently and are edited in different ways. A stroke is an out-
line. It describes the edges of a shape or it can be a simple line. You
can create strokes with the Line tool or the Pencil tool. A fill is a solid
shape, often contained or surrounded by a stroke. It is the surface area
of a shape and can be a color, gradient, texture, or bitmap. Fills can be
created with the Paintbrush tool and the Paint Bucket tool. The Oval,
Rectangle, and Pen tool can create shapes with either a stroke or a fill,
or both. You can edit the characteristics of strokes and fills, such as
color, in several ways. If the shape is selected on the Stage, a color
change to a stroke or fill can be made in any of the color palettes.
Because Flash uses vectors to describe shapes, you can change their
properties as much as you want without any loss in quality. It is impor-
tant to grasp the concept behind them because they are the basis for
drawing in Flash.

2

4 Click to
access the
Color Picker.

Active color

Did You Know?
You can change the stroke color in
three other places. Stroke color boxes
are also located in the Property
Inspector, the Color Mixer panel, and
the Swatches panel. In all cases,
select the stroke you want to change
and choose a new color from any of
the palettes.

You can change the line width and
style of a stroke or set the stroke color
to None in the Property Inspector. Click
the stroke you want to change to
select it, and then select any of the
options in the Property Inspector.
Setting the stroke color to None
removes the stroke from the shape.

No stroke color
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3

4Gradients

Color
Picker

Change the Fill Color

Click the Selection tool on the
Tools panel.

The pointer becomes an arrow.  

Click the fill of the shape to 
select it.

This is the area inside the stroke.

Click the Fill color box on the Tools
panel or Property Inspector.

Select a new color from the
palette.

4

3

2

1

Did You Know?
You can change the fill color in three
other places. Fill color boxes are also
located in the Property Inspector, the
Color Mixer, and the Swatches panel.
Just select the fill and choose a new
color from one of the palettes by click-
ing on a new color box.

See Also
See “Editing Fills with the Paint
Bucket” on page 103 for information on
changing the fill color.

1

2

No fill
color
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Creating Custom
Colors

Create a Custom Color by
Entering a Value

Open or expand the Color Mixer
panel. 

Enter values between 0 and 255 in
the RGB numeric entry boxes. 

Enter an alpha value between 0
and 100. 

Click the Options button in the
panel, and then click Add Swatch.

4

3

2

1

Each Flash document has its own color palette. The color palette dis-
plays as swatches when you access a color box or panel. The default
color palette is the Web-safe palette of 216 colors. Flash allows you to
edit and create new colors for strokes and fills in several ways in the
Color Mixer panel. You can alter a color's RGB values (assigning it dif-
ferent levels of Red, Green or Blue), Hue, Saturation, Brightness, and
Alpha (transparency). You can accomplish this by using sliders, drag-
ging on a color-space, or entering a numeric value that corresponds to
a specific color. In each case, you can save your color into the palette
for easy access.

1

4

Options button

3

2

Color space bar

Did You Know?
You can alter the RGB values with the
sliders located to the right of the
numeric entry boxes. Click the small
triangles, and then drag the sliders that
appear. Additionally, you can drag the
cursor over the Color space bar at the
bottom of the Color Mixer panel to
change the color interactively.

You can also specify a color using a
hexadecimal number in the Color
Mixer. A hexadecimal number is an
internal computer numbering scheme
that is used to identify colors in a color
palette.
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Create a Custom Color with
the Color Picker

Click a Stroke or Fill color box on
the Tools panel or the Property
Inspector.  

Click the Color Wheel button to
the far right of the palette.

Click a color from one of the
available pickers (Mac) or from the
Color Window (Win).

Click OK.4

3

2

1

1

2

3

4

Did You Know?
You can import and export solid and
gradient color palettes between Flash
files and other applications. You can
share color palettes between applica-
tions, such as Adobe Fireworks and
Adobe Photoshop. Click the Window
menu, and then click Color Swatches.
Click the Options button on the panel,
and then click Add Colors or Replace
Colors to import colors from a color
palette, or click Save Colors to export
as a color palette.

Working with Color Palettes
Each Flash file stores its own color palette, Web safe 216 by default.
If you change colors in the default color palette, you can save the
new palette as the default or change back to the Web safe 216
default. To view the color palette, click the Window menu, and then
click Color Swatches. To load or save the default palette, click the
Options button in the Color Swatches panel, and then click Load
Default Colors or Save As Default. To reload the Web-safe color
palette, click the Options button, and then click Web 216.

For Your Information

No fill color

C03FLCS4.qxp  10/16/2008  1:12 AM  Page 99



100

Adding Colors Using 
the Kuler Panel

Browse Themes and Add to the
Swatches Panel

Click the Window menu, point to
Extensions, and then click Kuler. 

Click the Browse tab.

To search for a theme, click in the
Search box, enter the name of the
theme, a tag, or a creator, and
then press Enter (Win) or Return
(Mac). 

IMPORTANT In a search, use
only alphanumerical characters 
(Aa-Zz, 0-9).

To narrow down the browse list,
click the popups, and then select
the filter options you want. Some
include Highest Rated, Most
Popular, Newest. 

◆ To save a search, click the first
popup, click Custom, enter your
search criteria, and then click
Save.

To browse for a theme, click the
View previous set of themes or
View next set of themes button. 

Select a theme in the panel.  

To add the theme to the Swatches
panel, click the Add Selected
Theme To Swatches button. 

7

6

5

4

3

2

1

The Kuler panel (New!) is an extension to Flash that allows you to use
groups of color, or themes in your projects. You can use the panel to
browse thousands of color themes, create your own using the comple-
mentary harmony rules, and share them with others in the Kuler com-
munity. After you find or create the theme you want, you can add it to
the Swatches panel for use in your project. You can access the Kuler
panel by using the Extensions submenu on the Window menu. The
Kuler panel is also available in the CS4 version of Photoshop, InDesign,
Illustrator, and Fireworks.

5

2

6

7

4

3
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Create or Edit a Theme

Click the Window menu, point to
Extensions, and then click Kuler. 

To create or edit a theme, do
either of the following: 

◆ Create a theme. Click the
Create tab.

◆ Edit a theme. Click the Browse
tab, select the theme you want
to edit, and then click Edit
Theme in Create Panel.

Click the Select Rule popup, and
then select a harmony rule or
Custom.

The harmony rule uses the base
color as the basis for generating
the colors in the color group, so
you can create a theme with
complementary colors. 

Select a color box, and then use
the sliders and the color wheel to
display the color you want. 

Use the buttons below the color
boxes to add/remove the theme
color, add the current stroke/fill
color as the base color, or adjust
the other colors. 

◆ Double-click a color box to set
the active color in Flash.

Upon completion, do any of the
following:

◆ Save theme. Click Save Theme,
name the theme, and then click
Save to create a new one.

◆ Add to Swatches Panel. Click
the Add This Theme to
Swatches button.

◆ Upload to Kuler. Click the
Upload Theme to Kuler button.

6

5

4

3

2

1

6

2

3

4

5

Colors added
from Kuler panel
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Editing Strokes with
the Ink Bottle

Use the Ink Bottle

Select a stroke on the Stage, and
then change Stroke attributes in
the Property Inspector. 

Click the Ink Bottle tool on the
Tools panel. 

The pointer becomes a small ink
bottle.

TIMESAVER Press S to select
the Ink Bottle tool.

Click on the stroke of the shape to
update it with the new attributes.

The stroke updates to the new
color.

3

2

1

There are a number of ways to change the stroke of an object. You can
select the stroke and change its characteristics in the Property
Inspector, the Swatch palettes, and the Color Mixer. If you need to
apply the stroke properties of one object to that of another, use the Ink
Bottle tool. The Ink Bottle tool holds the properties you've set for
strokes in any of the palettes. You can click any object on the Stage to
change the properties of its stroke (color, line weight and style) or add
a stroke to an object that doesn't have one.

1 Stroke Color

Stroke
Weight

Stroke Style

Built-in Stroke
styles 

3

Shape with
updated stroke

2

Did You Know?
You can click anywhere on the shape
with the Ink Bottle to change the
stroke. If the object on the Stage is
selected (stroke and fill), click down
with the Ink Bottle tool to update its
stroke.
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Editing Fills with the
Paint Bucket

Use the Paint Bucket

Change the Fill color box in either
the Property Inspector, the Colors
area of the Tools panel, or the
Color Mixer.

Click the Paint Bucket tool on the
Tools panel. 

The pointer becomes a small paint
bucket.

TIMESAVER Press K to select
the Paint Bucket tool.

Click in the fill of a shape on the
Stage.

The fill updates to the new color.

3

2

1

You can change the fill of an object with the Paint Bucket tool. The
Paint Bucket stores the fill color you've set on the Tools panel or in the
Property Inspector. You can change the fill color of any existing shape
on the Stage by touching down on the shape with this tool. You can
also add a fill to any shape that has a closed stroke. After you select
the Paint Bucket tool, you can select Paint Bucket sensitivity options
located at the bottom of the Tools panel.

2

3 Shape with updated fill

Paint Bucket
sensitivity

Paint Bucket Options

1

Did You Know?
You can set the sensitivity of the Paint
Bucket tool in the Options areas of the
Toolbox. These settings allow the Paint
Bucket tool to close gaps in a shape
(such as a break in the stroke line) and
adjust how large or small a gap needs
to be before Flash will close it.
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Ink Bottle appears
when you click on a
stroke.

Editing Strokes and
Fills with the
Eyedropper

Use the Eyedropper Tool to Edit
Strokes and Fills

Click the Eyedropper tool on the
Tools panel. 

The pointer becomes an
eyedropper.

TIMESAVER Press I to select
the Eyedropper tool.

Position the eyedropper over the
stroke or fill of a shape on the
Stage. 

◆ Strokes. When you are
positioned over a stroke, a tiny
pencil appears next to the tool.
When you click on the stroke
the Eyedropper becomes an Ink
Bottle.

◆ Fills. When you are positioned
over a fill, a tiny paint brush
appears next to the tool. When
you click on the fill the
Eyedropper becomes a Paint
Bucket.

Click on another shape's stroke or
fill to transfer the selected
attributes.

The stroke or fill updates to the
new color.

3

2

1

The Eyedropper tool allows you to select the attributes of a shape such
as fill and stroke color, and line weight and style, and then transfer
them to other shapes. This tool detects whether you are selecting a
stroke or a fill, and then changes into the Ink Bottle (when selecting
strokes) or the Paint Bucket (when selecting fills). Instead of taking
several steps to copy attributes from one shape to another, the
Eyedropper provides a quick means for storing and transferring attrib-
utes between editable shapes.

Paint Bucket appears
when you click on a fill.

1

Tiny Pencil appears
indicating
eyedropper is
positioned over a
stroke.

Tiny Paint brush appears
indicating eyedropper is
positioned over a fill.
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Creating Gradients

Create a Multi-Color Gradient

With the Selection tool, select the
fill or stroke of a shape on the
Stage.

In the Color Mixer panel, click the
Fill Style Type popup, and then
click Linear or Radial.

Click the Overflow popup, and
then select the gradient overflow
style you want to control colors
past the limits of the gradient
when publishing for Flash Player 
8 or later.

Position the pointer on the Color
Picker box to display a plus (+)
sign next to the pointer.

Click in the Gradient bar to create
a color proxy indicated by a little
box with a triangle on top.

TIMESAVER To remove a
proxy color indicator, drag it down.

Click one of the color proxy
indicators to select it.

Click a new color from the Color
Picker box above.

Drag the color proxy indicator
along the Gradient bar to adjust
the color placement.

Repeat steps 4-8 to add up to 15
more gradient colors.

9

8

7

6

5

4

3

2

1

Flash can create a number of paint effects in addition to solid colors.
Gradients are made up of two or more colors that gradually fade into
each other. They can be used to give depth to an object or create real-
istic shadows. Two gradient modes are available: linear and radial.
Linear gradients are made up of parallel bands of color. Radial gradi-
ents radiate from a center focal point. Both can be edited for color,
alpha, and position within a fill or stroke. You can add up to 16 colors to
a gradient, precisely control the location of the gradient focal point,
and apply other parameters. A gradient behaves like any other fill or
stroke. It can be saved to the palette as a swatch using the Color Mixer
panel Options button, and added to other shapes with the Paint Bucket
tool.

Example: 
3-Color
Linear
Gradient

1

5

2

6

4

3

7
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Using the Fill Lock

Lock Gradients

Create two simple shapes using
the Rectangle or Oval tool. 

Select the first shape on the Stage
with the Selection tool.  

Click the Paint Bucket tool on the
Tools panel.

TIMESAVER Press K to select
the Paint Bucket tool.

Click the Lock Fill button in the
Options area of the Tools panel. 

Select a Gradient from the Colors
area of the Tools panel or use the
Color Mixer or Property Inspector.

Click the Eyedropper tool on the
Tools panel, and then click on the
gradient fill in the first shape.

Click down on the second shape to
add the gradient fill.

7

6

5

4

3

2

1

As you increase the complexity and number of shapes in your movie, it
can become tricky to edit each object separately. When using gradient
fills on several objects you can choose to span a gradient across sev-
eral of these objects or give each object its own discreet gradient. The
Lock Fill feature allows you to control how a fill is applied, essentially
locking its position so that depending on where the shapes are posi-
tioned relative to the gradient, the one gradient spans all of the shapes.
If you apply the same gradient to multiple shapes with the Fill Lock off,
the gradient is applied to each shape independently. 

6

4

3

5

2 7

1

Shape 1 and 2
with Fill Lock

Shape 1 and 2
without Fill Lock

Did You Know?
You can quickly add a gradient that
spans all of your shapes. Select all of
the objects you want to fill, and then
choose a gradient. Click the Paint
Bucket tool and make sure Fill Lock is
not selected. With your shapes still
selected, click them with the Paint
Bucket.
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Using Paint Brush
Modes

Use Paint Brush Modes

Click the Brush tool on the Tools
panel. 

Click the Brush Mode popup in the
Options area on the Tools panel,
and then select from the following:

◆ Paint Normal. The brush paints
over everything including
strokes and other fills.

◆ Paint Fills. Painting only affects
existing fills and empty areas of
the Stage. Strokes are ignored.

◆ Paint Behind. The Paint Brush
only affects empty areas of the
Stage keeping existing lines
and fills intact.

◆ Paint Selection. Painting only
affects the selected areas you
define with any of the selection
tools.

◆ Paint Inside. The Paint Brush
only affects the fill of the shape
you started in, ignoring other
shapes and empty areas on the
Stage.

2

1

In addition to size, shape, and color settings for the Paint Brush tool,
you can control how the brush behaves when painting on existing
shapes and objects on the Stage. Paint Brush modes can restrict the
area affected by the tool to fills or selections, empty areas of the Stage
or specific shapes. When the Paint Brush tool is selected, a popup
menu appears on the Tools panel. Select from the following modes:
Paint Normal, Paint Fills, Paint Behind, Paint Selection, and Paint
Inside. Each performs a specific operation providing you with varying
levels of control as you paint. Flash previews your paint path as you
paint, but it only affects the areas you've specified in the Paint modes.
When you release the mouse, these previews disappear. 

Paint Normal

Paint Fills Paint Behind

Paint InsidePaint Selection

Brush mode
options

1

2
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Using the Spray 
Brush Tool

Use the Spray Brush Tool

Click the Spray Brush tool on the
Tools panel. 

Select a fill color for the default
spray of dots and other options in
the Property Inspector.

◆ Color Selector. Select a fill
color for the default spray
particle.

◆ Edit. Select a custom symbol
from the library. You can use
any movie clip or graphic
symbol in the library as the
spray particle.

◆ Scale. Scale the width and
height of a symbol used as a
spray particle.

◆ Random Scaling. Randomly
spray particles on the Stage
with different sizes.

◆ Rotate Symbol. Rotates the
symbol spray particle around a
center point.

◆ Random Rotation. Randomly
rotate spray particles on the
Stage.

◆ Width and Height. Specifies the
brush width and height.

◆ Brush Angle. Specifies the
spray angle of the particles.

Click or drag on the Stage where
you want the pattern to appear.

3

2

1

The Spray Brush tool (New!) allows you to spray particles onto the
Stage using the current fill color. If you want to create a more complex
pattern, you can also use a movie clip or graphic symbol from the
library as a particle.  You can adjust the spray pattern by selecting
Symbol and Brush options in the Property Inspector. The Symbol
options include Scale, Random scaling, Rotate symbol, and Random
rotation, while the Brush options include Width, Height, and Brush
angle.

1

23

FL 2.2
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Using the Deco Tool

Use the Deco Tool

Click the Deco tool on the Tools
panel. 

In the Property Inspector, click the
Drawing Effect list arrow, and then
select Vine Fill, Grid Fill, or
Symmetry Brush.

Select a fill color for the default
shape, or select a symbol.

◆ Color Selector. Select a fill
color for the default pattern.

◆ Edit. Select a custom symbol
from the library. You can use
any movie clip or graphic
symbol in the library as the
pattern.

Specify the advanced options you
want for the different effects;
options vary depending on the
selected effect.

Click the Stage or within the shape
or symbol (Grid Fill and Vine Fill)
where you want the pattern to
appear.

5

4

3

2

1

The Deco tool (New!) allows you to apply a kaleidoscopic drawing
effect to the Stage or a selected object on the Stage. You can apply
several effects: Vine, Grid, or Symmetry. The Vine effect fills the Stage,
symbol, object, or closed area with a vine pattern. You can also use
your own artwork (symbols) for the leaves and flowers.The Grid effect
fills the Stage, symbol, object, or closed area with a symbol from the
library. You can create  grid patterns, such as a tiled background or
checkerboard. The Symmetry effect arranges symbols symmetrically
around a central point, which you can control with a set of handles. You
can create circular elements, such as a planet. The default symbol for
the Symmetry effect is a 25 x 25 pixel black rectangle with no stroke.

4

5 3

1

2

FL 2.2
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Drawing with the 
Pen Tool

Use the Pen Tool to Create an
Open Path

Click the Pen tool on the Tools
panel. 

TIMESAVER Press P to quickly
select the Pen tool.

Click on the Stage.

An anchor point is created.

Move your pointer to another
position, and then click again.

Flash connects the two anchor
points.

Double-click to end the path.

TIMESAVER Ctrl+click (Win) or
Command+click a blank area to
leave the path open.

4

3

2

1

The Pen tool is the basis for vector drawing. The Pen tool now behaves
similarly to the Illustrator Pen tool to provide consistency across Adobe
software. Flash provides a number of ways to draw and edit objects
that are unique to Flash, but the Pen tool utilizes procedures that will be
familiar to those who have used other vector drawing programs. The
Pen tool utilizes anchor points and Bézier handles to create lines and
shapes and behaves in a way that is familiar to those who have used
other programs such as Adobe Illustrator and Adobe FreeHand. You
can use the Pen tool arrow to select a different pen to add, delete, or
convert anchor points. You can edit the anchor points and vectors to
create the drawings you want.

2 3

Open path drawn

1

Pen tools

Did You Know?
You can end an open path using a key-
board shortcut. Press A+click (Mac)
or Ctrl+click (Win).

See Also
See “Modifying Shapes with the Sub-
Selection Tool” on page 116 for infor-
mation on using tools.
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Use the Pen Tool to Create a
Closed Path

Click the Pen tool on the Tools
panel. 

TIMESAVER Press P to quickly
select the Pen tool.

Click on the Stage.

An anchor point is created.

Move your pointer to another
position, and then click again.

Flash connects the two anchor
points.

Move the pointer to a third
position, and then click again.

Flash connects the second and
third anchor points.

Move the pointer back to the first
anchor point. 

A small circle appears next to the
pen pointer indicating you can
close the path of the shape.

Click to close the shape.6

5

4

3

2

1

2 3

1

4

5

Closed path drawn

Did You Know?
You can delete an anchor point with
the Pen tool. Click the Pen tool arrow,
click Delete Anchor Point tool, and
then click the point you want to delete. 

You can add an anchor point with the
Pen tool. Click the Pen tool arrow, click
Add Anchor Point tool, and then click
where you want to add a point. 

You can create horizontal, vertical,
and 45 degree lines while you draw.
Hold the Shift key while you draw to
constrain a line to horizontal, vertical,
and 45 degree angles.

Pointer Description

Initial Anchor Point First pointer to create the beginning of
a new path.

Sequential Anchor Creates an anchor point with a line
Point connecting the previous anchor point.

Add Anchor Point Adds an anchor point to existing path.

Delete Anchor Point Deletes an anchor point within a path.

Continue Path Extends a new path from an existing
anchor point.

Close Path Closes the path of a drawing on the 
starting anchor point.

Join Paths Closes the path except not over the 
starting anchor point.

Retract Bézier Handle Displays Bézier handles when you point
to an anchor. Click to retract the handles
and revert to straight segments.

Convert Anchor Point Converts a corner point without 
direction lines to a corner point with 
independent direction lines. Use Shift+C
modifier keys to toggle the pen.

Understanding Pen Pointers
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Drawing Curves with
the Pen Tool

Create Curved Line Segments

Click the Pen tool on the Tools
panel. 

Click on the Stage without
releasing the mouse, drag up, and
then release the mouse.

Position the pointer to the right of
the original point, drag in the
opposite direction of the curve,
and then release the mouse when
the curve is where you want it.

Continue adding points as needed.
To end the path, double-click or
point to the last anchor point
drawn and click on it.

4

3

2

1

The Pen tool can be used to draw precise and complex curves by sim-
ply clicking and dragging it on the Stage. These curves can be modified
with precision by adjusting the Bézier handles that extend from the
anchor points, or you can move the anchor points themselves. In this
way, you can create any number of shape variations. For best results,
make the grid visible so aligning anchor points isn't such a mystery.

1

2

3

Curved line segment drawn

Did You Know?
You can select to Show Precise
Cursors instead of the tool icons in the
General tab of the Preferences dialog
box. When this option is selected,
drawing tools, such as the Pen tool,
appear as crosshairs for better preci-
sion and alignment to grids and guides.

You can convert a curve point to a cor-
ner point. Click the Pen tool arrow,
click Convert Anchor Point tool, and
then click the curve point you want to
covert to a corner point.
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Create S-Curves

Click the Pen tool on the Tools
panel. 

Click on the Stage without
releasing the mouse, drag down,
and then release the mouse.

Position the pointer to the right of
the original point, drag in the same
direction as the first drag, and
then release the mouse when the
curve is where you want it. 

Continue adding points as needed.
To end the path, double-click or
return to the last anchor point
drawn and click on it.

4

3

2

1

1

2

3

S-Curve drawn
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Modifying Shapes
with the Selection 
Tool

Use the Selection Tool to Modify 
a Shape

Click the Oval tool on the Tools
panel and then create a simple
oval shape.

Click the Selection tool on the
Tools panel. 

The pointer becomes an arrow.

Make sure the shape you want to
modify is not selected.

Position the pointer on the edge of
the shape, and then drag to modify
the shape.

You can pull the curve to any
position.

4

3

2

1

In Flash, unlike other vector drawing programs, you can edit shapes
and lines in a unique, freeform way by simply dragging with the Arrow
Selection tool. You can quickly adjust the curve or corner of a shape or
line without having to select anchor points or use any other tools. This
way of editing shapes is also useful for creating shape tweens where
amorphous, organic movement is desired. This is what sets Flash apart
from other animation tools and gives it its distinctive style. Additionally,
you can convert curved line segments into corner points with this sim-
ple drag technique.

2

1

4

Modified shape
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Convert Line Segments with the
Selection Tool

Create a simple oval shape using
the Oval tool.

Click the Selection tool on the
Tools panel. 

The pointer becomes an arrow.

Make sure the shape you want to
modify is not selected.

Position the pointer on the edge of
the shape.

Press Option+drag (Mac) or
Alt+drag (Win) to create a corner
point.

5

4

3

2

1

2

1

4

Modified shape

More corners added
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Modifying Shapes 
with the Sub-
Selection Tool

Use the Sub-Selection Tool to
Modify a Shape

Create a simple oval shape using
the Oval tool.

Click the Sub-Selection tool on the
Tools panel. 

The pointer becomes an empty (or 
white) arrow.

Click on the edge of the shape to
reveal the anchor points, and then
click on an anchor point to 
select it or drag a selection
rectangle to select multiple anchor
points.

The anchor points are the little
white squares around the edge of
the shape. When selected, Bézier
handles appear on either side of
the anchor point.

Grab one of the handles or the
anchor points themselves and
drag it, and then release the
mouse.

4

3

2

1

Vector shapes are made up of anchor points connected by line seg-
ments. There are two types of anchor points: corner points and curve
points. Corner points connect two line segments in a sharp angle such
as the corner of a square. Curve points define a curve or positions
along a straight line and can be modified with Bézier handles. These
handles extend out from the curve point and allow for very precise
modification of the shape of the curve. The Sub-Selection tool works
hand-in-hand with the Pen tool to create and modify shapes and lines
in this way.

2

3

1

4
Did You Know?

You can also use the arrow keys on
the keyboard to move selected anchor
points. Select one or more anchor
points with the Sub-Selection tool, and
then press the arrow keys to move the
anchor point and its connected lines in
the direction of the key you press.  
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Convert Corner Points to 
Curve Points 

Create a simple rectangle shape
using the Rectangle tool.

Click the Sub-Selection tool on the
Tools panel. 

The pointer becomes an empty (or
white) arrow.

Click on the edge of the shape to
select it and then click on one of
the corner points to select it.

Press Option+drag (Mac) or
Alt+drag (Win) the point to convert
it to a curve point and create
Bézier handles.

Convert Curve Points to 
Corner Points 

Create a simple oval shape using
the Oval tool.

Click the Pen tool on the Tools
panel. 

The pointer becomes a small pen.

Click on the edge of the shape to
reveal the anchor points.

Position the pointer over one of
the curve points. 

A small corner icon appears.

Click on the point to convert it to a
corner point.  

5

4

3

2

1

4

3

2

1
1

4

3

1

2

4

5 All anchor points
converted to
corner points.

2
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Using the Free
Transform Tool

Change the Scale of an Object

Select the object by clicking on it
or by dragging a selection
marquee around it with the
Selection tool. 

Click the Free Transform tool on
the Tools panel. 

TIMESAVER Press Q to select
the Free Transform tool.

Click the Scale Modifier button in
the Options area of the Tools
panel. 

Drag any of the small handles on
the bounding box to change the
size of the shape. The corner
handles resize proportionally while
the handles along the sides resize
either horizontally or vertically.

To change the transformation
point, drag the circle handle. 

5

4

3

2

1

There are a number of ways to change the scale or size of graphics in
Flash. The Free Transform tool on Tools panel allows you to interac-
tively scale and rotate any selected object or shape on the Stage.
Nearly every object in Flash can be transformed with these two func-
tions of the Free Transform tool including groups, symbols, text,
bitmaps, and editable shapes. The Free Transform tool allows you to
select an object on the Stage and then interactively change its size or
rotate it freely. Both options are available at once depending on where
you place your mouse on the bounding box that appears.

3

2

4

5

Working with the Transformation Point

When you transform an object, a transformation point appears at the
center of the object. The point is initially placed in the center of the
object, but you can move it at any time. To move the transformation
point during a transformation, drag the point. To set it back to the
center, double-click the point. To switch the point of origin for a scale
or skew, Alt+drag (Win) or Option+drag (Mac) the point. To monitor
the location of the transformation point (X and Y positions), click the
center square in the grid in the Info panel (available on the Windows
menu).

For Your Information
Did You Know?

You can restore a transformed object.
Select the transformed object, click the
Modify menu, point to Transform, and
then click Remove Transform. 

You can reset a transformed object. If
you want to redo a transformation,
select the object, and then click the
Reset button in the Transform panel
(available on the Window menu). 

FL 2.3
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Rotate and Skew an Object

Select the object by clicking on it
or by dragging a selection
marquee around it.

Click the Free Transform tool on
the Tools panel.  

TIMESAVER Press Q to select
the Free Transform tool.

Click the Rotate/Skew Modifier
button in the Options area of the
Tools panel.

Drag any of the corner handles on
the bounding box to rotate the
shape. Drag the handles along the
side to skew the object.

To change the transformation
point, drag the circle handle. 

5

4

3

2

1
4

3

2

5

4 Skew

Rotate

Did You Know?
You can hold down the Shift key to
constrain the rotation scale propor-
tionally. When rotating, it constrains
the rotation to 45-degree turns. 

Working with Scale and Rotate
In the Default mode, both Scale and Rotate are enabled. Move the
pointer to any of the four corner handles in the bounding box to
enable the Rotate function. Scale and Rotate work relative to a cen-
ter transformation point on the shape, which becomes visible when
the shape is selected with the Free Transform tool. Move this point if
you want to scale or rotate a shape from a different part of the
shape. This is especially important when tweening and animating.
You can change the scale and rotate objects by entering values in
the Transform panel or in the Property Inspector. You can also
access all of the Transform modes and some additional effects, such
as Flip Horizontal and Vertical from the Transform submenu in the
Modify menu.

For Your Information
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Using Transform
Options for Shapes

Distort a Shape

Select the object.

Click the Free Transform tool on
the Tools panel.  

TIMESAVER Press Q to select
the Free Transform tool.

Click the Distort Modifier button in
the Options area of the Tools
panel.

Drag any of the corner handles on
the bounding box to distort the
shape.

Drag any of the side handles on
the bounding box to skew or
stretch the shape.

Change the Envelope of a Shape

Select the object.

Click the Free Transform tool on
the Tools panel.  

TIMESAVER Press Q to select
the Free Transform tool.

Click the Envelope Modifier button
in the Options area of the Tools
panel.

Drag any of the handles on the
bounding box to pull the shape in
any direction or use the Bézier
handles to fine tune the curves.

4

3

2

1

5

4
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1

In addition to the scale and rotation changes that can be applied to
groups, symbols, bitmaps, text and editable shapes, there are two addi-
tional transforms available only to editable shapes. Distort and
Envelope are two modes available in the Free Transform tool options
that enable you to transform the vectors of editable shapes to varying
degrees. Distort transformations work on adjoining edges, tapering
them down to vanishing points, similar to perspective. Envelope trans-
formations allow you to warp the edges of a shape by splitting it up into
smaller portions each controlled by their own vectors and anchor
points. 

3

4
2

5

4

3

2

FL 2.3
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Transforming 
Gradient Fills

Adjust a Gradient Fill

Click the Gradient Transform tool
on the Tools panel. 

Click the gradient fill to select it.

A bounding box appears around it. 

Position the pointer over an editing
handle on the bounding box to
identify its function.

◆ Center point. Four-way arrow.

◆ Focal point. Inverted triangle.

◆ Size. Circle with an arrow.

◆ Rotation. Four arrows in the
shape of a circle.

◆ Width. Double-ended arrow.

Click and drag an editing handle to
adjust the gradient fill.

4

3

2

1

After you create a gradient fill, you can transform it by adjusting the
size, rotation, width, or center of the fill with the Gradient Transform
tool (formerly called the Fill Transform tool). For a radial gradient, you
can now adjust the focal point (center) of a gradient fill applied to an
object. You can also use the Gradient Transform tool to modify a bitmap
fill.

2 4

Use Color panel to change
color gradient settings

Radial gradient

Linear gradient

See Also
See “Modifying a Bitmap Fill” on page
206 for information on using the
Gradient Transform tool with bitmaps.

1

FL 2.3
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Moving and Rotating
Objects in 3D Space

Move Objects in 3D Space

Click the 3D Translation tool on the
Tools panel.  

TIMESAVER Press G to select
the 3D Translation tool.

Click the Global Transform button
on the Tools panel to select it for
global mode or deselect it for local
mode. The default is global.

TIMESAVER Press D to toggle
between global and local mode.

Select one or more movie clip
objects.

◆ When you select multiple movie
clips, and move one of them,
the others move in the same
way. Shift double-click one of
the selected objects to move
the axis controls to that object.

Drag the arrow tips (x- and y-axis)
in the direction of the arrow or the
black dot (z-axis) up or down.

◆ You can also move the object
manually by using the Property
Inspector.

4

3

2

1

In Flash, you can add 3D perspective effects (New!) to a movie clip by
moving and rotating it in 3D space on the Stage. When you move or
rotate a movie clip  by the z axis, it becomes a 3D movie clip. Moving an
object in 3D space is called translation, and rotating an object in 3D
space is called transformation. Flash provides two different 3D space:
global and local. Global 3D space is the Stage space, while local 3D
space is the movie clip space. The default mode is global. You can
move a movie clip in 3D space with the 3D Translation tool. When you
do, three axes appear in the 3D object: the x axis is read, the y axis is
green, and the z axis is blue. In addition, you can rotate a movie clip in
3D space with the 3D Transformation tool. When you do, you can rotate
around an individual axis or use the orange free rotate control to rotate
around the x and y axes at the same time. If you want to change the
effect of the rotation, move the center point. When you select a 3D
object, it appears with a 3D axis overlay.

1

2

3 4

FL 2.3
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Rotate Objects in 3D Space

Click the 3D Rotation tool on the
Tools panel.  

TIMESAVER Press W to select
the 3D Rotation tool.

Click the Global Transform button
on the Tools panel to select it for
global mode or deselect it for local
mode. The default is global.

Select one or more movie clip
objects.

◆ When you select multiple movie
clips, and move one of them,
the others move in the same
way. Shift double-click one of
the selected objects to move
the axis controls to that object.

Drag one of the four axis controls
to rotate around that axis, or the
free rotate control to rotate x and y
axis at the same time.

To move the rotation control
center point relative to the movie
clip, drag the center point.

◆ Double-click the center point to
move it back to the center of
the movie clip.

5

4

3

2

1

Did You Know?
You can turn the overlay on and off.
Click the Edit (Win) or Flash (Mac),
click Preferences, click General, select
or clear the Show axes for 3d movie
clips check box, and then click OK.

1

2

3

5

4
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The Perspective Angle (New!) affects the size and view of 3D movie
clips on the Stage. It’s like zooming in and out with a camera lens,
which changes the angle of view through the lens. When you increase
the angle, 3D objects appear closer to the viewer. When you decrease
the angle, 3D objects appear further away. The default angle is 55
degrees of view, which is like a normal camera lens. You can adjust the
value from 1 degree to 180 degrees. You can control only one view-
point, or camera. Each Flash file has only one Perspective Angle.  

Changing the
Perspective Angle 
in 3D Space

Change Perspective Angle in 
3D Space

Select the 3D movie clip instance
on the Stage that you want to
change. 

Click the Window menu, and then
click Properties to open the
Property Inspector.

Enter a new value in the
Perspective Angle box or drag the
hot text to change the value in the
Property Inspector.

3

2

1

Did You Know?
You can automatically change the
appearance 3D objects when you
change the size of the Stage. Click the
Modify menu, click Document, select
or clear the Adjust 3D Perspective
Angle to preserve current stage pro-
jection check box, and then click OK.

2

3

1

FL 2.3
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Vanishing Point (New!) gives you the ability to move 3D movie clips
and still maintain the same visual perspective of the original. Vanishing
Point controls the orientation of the z-axis of 3D movie clips on the
Stage. As you move the z-axis, 3D movie clips recede towards the
Vanishing Point, which you can adjust to create the appearance you
want. Each Flash file has only one Vanishing Point. If you move the
Vanishing Point back to the default position in center of the Stage, you
can use the Reset button in the Property Inspector.  

Adjusting the
Vanishing Point 
in 3D Space

Adjust the Vanishing Point in 
3D Space

Select the 3D movie clip instance
on the Stage that you want to
change. 

Click the Window menu, and then
click Properties to open the
Property Inspector.

Enter an x- and y-axis value in the
Vanishing Point boxes or drag the
hot text to change the value in the
Property Inspector.

As you drag the hot text, guides
indicating the location of the
Vanishing Point appears on the
Stage. 

To move the Vanishing Point back
to the center of the Stage, click
the Reset button in the Property
Inspector.

4

3

2

1

2

3

4

1

FL 2.3
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Cutting and Pasting
Graphics Between
Layers

Paste Objects Between Layers

Create or open a document with
several layers. 

Select one or more objects on the
Stage.  

Flash selects the object’s layer in
the Timeline.

Click the Edit menu, and then click
Cut or Copy.

Select a destination layer in the
Timeline.

Click the Edit menu, and then click
Paste In Center.

Flash pastes the objects on the
Stage in the middle of the active
layer.

5

4

3

2

1

Unless you lock or hide layers, or lock objects, the graphics on all lay-
ers are available for editing. You can select objects on one or more lay-
ers, cut or copy them, and then paste them all into a single layer. Flash
can have only one layer active at a time. When you create and paste
graphics, Flash places them on the active layer of a document. You can
paste objects in two different ways: Paste In Center and Paste In Place.
Paste In Center puts objects in the center of the open Flash window,
which might not be the Stage. If you want to paste to the center of the
Stage, you need to center the Stage in the open window. Paste In
Place puts objects at the same location it had been when you cut or
copied it.

2

1

4

Shape pasted on
layer 2 in the center.

Did You Know?
You can use the area around the Stage
to store graphics and other objects.
Flash allows you to use the area
around the Stage, called the
Pasteboard, to store items for use later
without having them appear on the
Stage when you play the movie (SWF)
file.
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Use the Paste In Place
Command Between Layers

Create or open a document with
several layers. 

Select one or more objects on the
Stage.  

Flash selects the object’s layer in
the Timeline.

Click the Edit menu, and then click
Cut or Copy.

Select a destination layer in the
Timeline.

Click the Edit menu, and then click
Paste In Place.

Flash pastes the objects into their
original locations on the Stage.

5

4

3

2

1

4

Shape pasted on
layer 2 in place.

1

2
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Working with
Graphics on Different
Layers

Edit Object on Inactive Layers

Create or open a document with
several layers. 

Click the Selection tool on the
Tools panel.  

Select an object on the Stage.  

Flash selects the object’s layer in
the Timeline.

Click a blank area of the Stage.

Flash deselects the object but
keeps the active layer.

Make changes to another object in
another layer (inactive layer)
without actually selecting the
object. You can do any of the
following:

◆ Drag an object’s outline to
reshape it.

◆ Select a tool on the Tools panel,
such as the Paint Bucket tool,
and use it to modify the object.

Flash modifies the object in the
inactive layer. The active layer
didn’t change. Flash changes
active layers only if you select an
object.

5

4

3

2

1

When you select an object on the Stage, Flash selects the object’s
layer in the Timeline. The reverse is also true. When you select a layer
in the Timeline, Flash selects all the objects for that layer on the Stage.
As you work with objects on different layers, it helps to know how
selections work. Unless you lock or hide layers, or lock objects, the
objects on all layers, either active or inactive, are available for editing.
You can activate a layer and edit objects on inactive layers.

2

Layer 1 active

3

4

Layer 1 still active

5

1
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Distributing Graphics
to Layers

Place Selected Objects on
Separate Layers

Create or open a document with
several objects on a single layer. 

Select all the objects on a single
layer you want to distribute to
separate layers.  

TIMESAVER Click the Edit
menu, and then click Select All or
press A+A (Mac) or Ctrl+A (Win).

Click the Modify menu, point to
Timeline, and then click Distribute
To Layers.  

TIMESAVER Press A+Shift+D
(Mac) or Ctrl+Shift+D (Win) to
distribute to layers.

Flash creates a layer for each
object. New layers appear at the
bottom of the Timeline in the order
in which you originally placed
them on the Stage. Each object is
placed in the same location on the
Stage (like the Paste In Place
command).

3

2

1

If you have several objects on a single layer, and need to move them
onto separate layers, you can use Cut and Paste in place for each
object or you can save time by using the Distribute to Layers command.
The Distribute to Layers commands puts each object (shapes, groups,
and symbols) in a selection on a separate layer; any unselected objects
remain on their original layer. This command comes in handy when you
want to create a motion tweening animation, which requires objects to
be on individual layers. 

2

Shape on layer 5

Text on layer 3

Shape on layer 4

Text on layer 2

See Also
See Chapter 8, “Animating with Motion
Tweening” on page 231 for information
on using motion tweening.

1
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The Drawing category on the Preferences dialog box contains a num-
ber of drawing settings that control the sensitivity and behavior of
Flash's drawing tools. Make changes to the tolerance levels for
smoothing or straightening, set the sensitivity for line and shape recog-
nition, or fine-tune snapping. You can exercise greater control over
your drawing or allow Flash to perform corrections and adjustments as
you draw. You can customize the way you use Pen tools, draw connect-
ing lines and smooth curves, and recognize lines and shapes. 

Changing Drawing
Settings

Change the Drawing Settings

Click the Flash (Mac) or Edit (Win)
menu, and then click Preferences. 

Click the Drawing category.

Specify the drawing option you
want:

◆ Pen Tool options. Select check
boxes to show pen preview,
solid points, and precise
cursors.

◆ Connect Lines. Determines how
close the ends of any two lines
need to be before Flash
connects them. It controls when
a line is converted into a
perfectly straight line. 

◆ Smooth Curves. Determines the
amount of smoothing applied to
a drawn line. The lower the
smoothing applied, the closer
the line appears to what you
have drawn. 

◆ Recognize Lines. Defines how
straight a line drawn with the
Pencil tool must be before it’s
converted into a perfectly
straight line.

◆ Recognize Shapes. Sets how
precise simple geometric
shapes must be drawn before
they are detected as shapes.

◆ Click Accuracy. Determines how
near to a shape the pointer must
be before it’s recognized. 

◆ IK Bone Tool. Automatically sets
the transformation point. (New!)

Click OK.4

3

2

1 2

3

4

C03FLCS4.qxp  10/16/2008  1:17 AM  Page 130



535

Index

A
Actions panel

breakpoints, setting, 385
viewing, 349

ActionScript Editor, debugging with, 
376-377

ActionScript Server files, 14
ActionScript Virtual Machine (AVM), 351
ActionScripts, 10, 131, 347. See also

behaviors; components; conditional
statements; debugging; dot syntax; 
methods; properties

animation, creating, 282
clip events, 365-366
data types, 360
for dynamic text, 180
external SWF files, loading, 418
files, 14
frame events, 364
functions, using, 361
motion tween as ActionScript, 

copying, 244, 253
mouse events, 362-363
new version, introducing, 351
preferences, setting, 356
printing with, 489
video with, 328-329
warning preferences, 65

activating masks, 295
Adaptive color palette, 477
Add Statement, 349
Adjust Color effect, 240-241
Adobe Air, 470-471

create, 470
publish, 471

Adobe After Effects CS2, 342
Adobe Bridge, 14-15
Adobe ConnectNow, 508

Adobe Fireworks. See Fireworks
Adobe Flash Exchange Web site

commands, downloading, 459
Extend link for accessing, 4
resources on, 27
updates and support on, 26-27

Adobe Flash Player. See Flash Player
Adobe Flash Support Online Web site

templates on, 13
updates and support on, 26-27

Adobe Flash Video. See Flash movies; FLV
files

Adobe Illustrator. See Illustrator
Adobe Photoshop. See Photoshop
Adobe Premiere for alpha masks, 344-345
Adobe Soundbooth, 303, 321
Adobe Stock Photos. See Stock Photos
Adobe Version Cue. See Version Cue
ADPCM compression, 318
advanced colors. See colors
Advertising templates, 13
Alert component, adding, 406-407
alignment

with guide layers, 41
HTML alignment, setting, 475
of paragraph text, 172

alpha
instance alpha, modifying, 158, 160
masks, working with, 344-345
motion tween, adding to, classic, 262
publishing movies, setting on, 477
shape tween alpha, changing, 279

anchor points, 81
arrow keys for moving, 116
corner points to curve points, 

converting, 116-117
curve points to corner points, 

converting, 116-117
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aanncchhoorr  ppooiinnttss  ((ccoonnttiinnuueedd))
deleting, 111
Pen tool using, 110
types of, 116-117

AND conditional statement, 370
animations. See also frame-by-frame ani-

mation; GIF files; motion tweening
anti-aliasing for, 176
buttons, adding to, 151
of filters, 241
masks, animating, 300-301
symbols, converting to, 139
sync sounds, adding, 305

anti-aliasing text, 176
API (application programming interface)

and components, 413
Apple Final Cut Pro, 342

alpha masks, working with, 344-345
Arial font, 176

built-in Flash device fonts for, 179
armature, 283-288
Arrange command, 133
arrow keys, 116
assets in Library, 134-135
attachMovie() method, 366
attributes, list of, 451
audience, determining, 8
audio. See sounds
Audio Video Interleaved (AVI) files. See AVI

files
authoring parameters, 440, 441
Auto Format, 349
Auto Kerning, setting, 169
AutoCAD DXF. See DXF files
AVI files, 325

exporting movies to, 490-491
AvidXpress DV, 342

B
Back button on Edit bar, 46
backgrounds

attributes, 450
Property Inspector, changing color in, 16

ball animation. See shape tweening
bandwidth and debugging, 375
batch processing video encoding, 342-343

BBEdit, 354
behaviors, 10-11

adding behaviors, 371
instance, changing symbol behavior of,

144-145
sounds with, 310-311
Start/Stop Dragging Movie clip

Behaviors, 372
symbol behavior, changing, 144
video with, 328-329
warn on behavior symbol conversion, 65

Behaviors panel, 371
Bevel effect, 240-241
bevel joins, 75
Bézier handles, 81

Pen tool using, 110
Bind tool, 283, 288
bindings, 431

creating, 444-445
modifying, 446-447
Web Services (WSDL) documents and,

434
Bindings tab, Component Inspector, 391,

440. See also bindings
bit depth options, 478
bit rate for sounds, 319
bitmaps

Break Apart for fill patterns, 205
center point of fill, changing, 206
compression, setting, 204
fills

Break Apart for fill patterns, 205
center point, changing, 206
orientation, changing, 206-207
resizing, 206-207

Find and Replace for, 186
Fireworks files, importing, 198-199
graphics, 188
Illustrator, importing from, 190
Magic Wand, editing with, 208-209
orientation of fills, changing, 206-207
outside editor, editing in, 202-203
Photoshop import preferences, 192-193
PNG bitmaps, importing, 198-199
preferences, setting, 63
replacing, 203
resizing fills, 206-207

Z00FLCS4.qxp  10/15/2008  12:31 PM  Page 536



Index 537

Stage, importing bitmap to, 196
support for, 189
swapping, 197
text, 176
tracing bitmaps, 210

blending
instance blend, modifying, 159
shape tween, setting for, 278

Blur effect, 240-241
BMP files, 187
Bones tool, 283-288
Boolean data, 360
borders

for dynamic text, 180
for input text, 181
for Label components, 410

Bound To dialog box, 447
Break Apart, 163, 174-175

bitmap fill pattern, creating, 205
breaking

instances, 155
setting breakpoints, 385
text fields, 174-175

BREW Handsets, 13, 498
brightness

instances, modifying brightness of, 158
motion tween, adding to, classic, 262

Bring to Front/Bring Forward, 133
browsers

identifying playback browser, 9
printing from Flash Player, 489
system requirements, 2

building movies, 10-11
Button component, adding, 402-403
button objects, 355
buttons. See also RadioButton

animation, adding, 151
creating, 150-151
enabling/disabling, 152
invisible buttons, creating, 153
mouse events, attaching, 363
window sizing buttons, 19

C
calling functions, 296
camera data file information, 472-473
caps, 75

case-sensitivity in ActionScripts, 347
cell phones

content for PDA, creating, 498
deployment of Flash movies to, 501

center of gradient fills, changing, 121
centering text, 172
characters. See also kerning

breaking text fields into, 174
for dynamic text, 180
for input text, 181
options, setting, 182

circles, creating, 79
classes

object-oriented programming, 348
working with ActionScript 3.0, 352-353

classic tween. See motion tweening
Clear Keyframe function, classic, 258-259
clip events, 365-366

attaching to movie clips, 366
Clipboard

pasting images from, 201
preferences, setting, 63

Close button, 19
closing

documents, 28
History panel, 453
panels, 52

code hints, 349
in debugging, 377
setting, 356

ColdFusion, 414
collapsing. See maximizing/minimizing
Color Mixer

bitmap fill, selecting, 205
fill colors, changing, 97
gradients in, 105
for shape tween, 279
specifying colors in, 98
stroke color, changing, 98
text colors, changing, 167

color palettes
importing, 99
for shape tween, 279
type options, 477
Web 216 color palette, 477
working with, 98-99

Color Picker, 98-99
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colors. See also backgrounds; color
palettes; GIF files; gradients;
instances; PNG files; RGB colors;
Swatches panel; syntax-coloring

advanced colors
motion tween, adding effects to, 

classic, 262
simultaneously modifying color and

transparency, 160
attributes, 450
fill colors, changing, 96-97
Find and Replace for, 186
font colors, changing, 167
highlight color preferences, setting, 162
instances, modifying color of, 158-159
Kuler panel, 100-101
motion tween, adding effects to, classic,

262
shape tween colors, changing, 279
stroke color, changing, 98
TextArea component, adding, 400-401
tint color of instance, modifying, 158
values, creating custom colors with, 98

column of vertical text, creating, 170
ComboBox component, adding, 394-395
commands, 31

deleting names of, 458-459
help commands, 25
History panel, saving steps as command

in, 458-459
for Onion Skin markers, 229
running command, 459
saving steps as, 458-459

comments
in Actions panel, 349
with ActionScript Editor, 377
breakpoints, setting, 385

compatibility of ActionScripts, 351
Component Inspector, 391. See also

components; parameters
authoring parameters, 440
Bindings tab, 440, 444
description of, 440
Schema tab, 440, 448, 449

components, 10-11, 14, 389. See also bind-
ings; DataGrid component; 
parameters; schemas

Alert component, adding, 406-407
API (application programming interface)

in, 413
attributes, modifying, 450
basic components, understanding, 

390-391
Button component, adding, 402-403
categories of, 391
CheckBox component, adding, 396-397
ComboBox component, adding, 394-395
DataHolder component, 431, 432-433
forms, building, 412
Label component, adding, 410-411
List component, adding, 408-409
Loader component, adding, 418-419
MenuBar component, adding, 404-405
NumericStepper component, adding,

420-421
preloaders with, 418
ProgressBar component, adding, 
422-423
RadioButton component, adding, 

398-399
ScrollPanel component, adding, 424-425
TextArea component, adding, 400-401
TextInput component, adding, 392-393
Tree component, adding, 426-427
WebServicesConnector component, 

436-437
Window component, adding, 428-429
XMLConnector component, 438-439

compression
bitmap compression, setting, 204
of Flash movies, 468
for sounds, 318

conditional statements, 367
using, 370

connected lines, drawing, 130
Consumer Devices, 13, 498
context-sensitive help, 376
Convert To Symbol dialog box, 139, 149
Copy Frames command, 220-221
Copy Steps button, 460
copying

bitmap images, 201
files, 21
frame sequence, 43
keyframes, 43, 220
layers or folder contents, 38-39
motion tweens, 252-253
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other programs, images from, 201
steps between documents, 460-461

corner points to curve points, converting,
116-117

CPU requirements, 9
CSS (Cascading Style Sheets), 183
cue points, 343
Current Script tag, 349
curve points to corner points, converting,

116-117
curves

drawing smooth curves, 130
line segments, creating, 112
Pen tool, drawing with, 112-113
S-curves, creating, 113
shapes, optimizing, 77

customizing. See also colors
color palette, 477
keyboard shortcuts, 58
Tools panel, 50-51

D
data binding. See bindings
data components. See components
data types, 360

Web Services (WSDL) documents and,
434

DataGrid component
adding, 414-415
with DataHolder component, 432-433
local data provider, using, 416-417
options, modifying, 430

DataHolder component, 431, 432-433
Debugger, 380-382. See also properties; 

variables
ActionScript 2.0, 382
ActionScript 3.0, 380-381
breakpoints, setting, 386
stepping through code, 387

debugging, 373. See also Debugger
in Actions panel, 349
with ActionScript Editor, 376-377
bandwidth and, 375
breakpoints, 376
concepts of, 374-375
Flash movies, permitting debugging of,

468
Flash Player, 388

manual debugging, 388
with Movie Explorer, 378-379
planning and, 375
testing and, 375

Deco tool, 109
defaults

Snap Align defaults, saving, 95
Toolbar defaults, restoring, 51

delay, setting, 356
deleting. See also masks; motion tweening

anchor points, 111
Command menu, name from, 458
commands, names of, 458-459
files in dialog box, 22
font mapping, 177
frames, 43
keyboard shortcut sets, 58-59
keyframes, 218-219
layers/folders, 34-35
panel sets, 57
scenes, 45
shape tween, keyframes from, 272

delivery computer system, identifying, 9
deployment

Flash deployment kit, 466
to other devices, 501

device fonts, setting, 178-179
DICOM file information, 472-473
dictionaries, using, 184
Digital Juice, 304
Digital video (DV) files, 325
display components. See components
distorting shapes, 120
Distribute to Layers command, 129
dithering on publishing movies, 478
docking/undocking panels, 54
Document window, 7, 30-31

frame rates, changing, 256
documents. See also layers; printing; 

projects
arranging multiple windows, 18
blank document, creating, 12
closing, 28
copying steps between documents, 

460-461
creating

Adobe Air, 470
existing documents, opening, 14-15
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ddooccuummeennttss  ((ccoonnttiinnuueedd))
general preferences, setting, 60
languages for, 181
last saved version, reverting to, 20
launching, opening documents on, 5
mouse, resizing windows with, 19
moving document windows, 19
multi-language authoring, 181
projector document, creating, 481
properties

setting up, 10
working with, 16-17

recently opened documents, opening, 15
resizing document windows, 19
saving, 20

compacting document when, 20
different name/location, saving 

with, 21
formats for, 22
multiple documents, 20
templates, saving as, 23

switching between, 18
templates

creating new document from, 13
saving document as, 23

dot syntax
description of, 357
movie clips, applying to, 358-359

Down state for buttons, 150
downloading

commands, 459
10-second rule, 488

drag-and-drop
DataGrids, 415
keyframes, 221
Library items, 134-135
motion tween, keyframes in, 258

drawing
Line tool for, 75
masks, 294
model options, 61
Oval tool, 78
Pencil tool for, 76-77
Polystar tool, 80
Rectangle tool, 78-79
rounded rectangle, 79
selection examples, 81
settings, changing, 130

Drop Shadow effect, 240-241
duplicating profiles, 486
DXF files, 189

exporting movies to, 490-491
dynamic media, 10
dynamic text. See text

E
ease properties. See also motion tweening

shape tween, setting for, 278
ECMAScript, 349
Edit bar, 7

scenes, selecting, 44
showing/hiding, 46

Edit in New Window mode, 140
Edit In Place mode, 140
Edit Snapping dialog box, 94-95
editable parameters, 442
editing. See also bitmaps; outside editors;

symbols
keyframes, 220-221
Library, items in, 136-137
masks, 296
Onion Skins, 227
profile properties, 483
scene for editing, selecting, 47
sounds, 320
with Video Encoder, 342-343

effects, sound, 317
e-mail 

sending a document, 507
embedding. See also fonts

audio files, 305
data providers, 416-417
empty keyframe, creating, 214-215

Enable Simple Buttons command, 152
Enhanced Metafile (EMF)

exporting movies to, 490-491
support for, 189

EPS files, 187
exporting movies to, 490-491
importing options, 194

equals (=) statement, 370
event handlers

clip events, 365-366
description of, 362
frame events, 364
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events. See also ActionScripts; event 
handlers

mouse events, 362, 363
sounds, triggering with, 312

existing documents, opening, 14-15
expanding/collapsing. See maximizing

minimizing
exporting. See importing/exporting
Extend link, 4
Eye icon, 36
Eyedropper tool

for bitmap fills, 205
fills, editing, 104
strokes, editing, 104

F
file formats

exporting movies to different formats,
490-491

import file formats, 189
list of existing documents, opening, 

14-15
files

debugging, file names and, 374
deleting, 22
text files, loading, 165

fills. See also bitmaps; gradients
Selection tool, selecting with, 84
colors, changing, 96-97
Eyedropper tool, editing with, 104
locking gradients, 106
Paint Bucket, editing with, 103
text fills, 167

filter effects, applying, 240-241
Find and Replace, 186

for active script, 349
Fireworks

importing files, 198-199
pasting images from, 201

.fla files. See documents
Flash CS4, 1
Flash deployment kit, 466
Flash File for mobile devices, 498
Flash Live Video files. See FLV files
Flash movies, 14 See also debugging; pub-

lishing movies
Bandwidth Profiler, working with, 488

different formats, exporting movie to,
490-491

exporting
different formats, exporting movies

to, 490-491
video clips into FLV format, exporting,

346
Flash Player, optimizing for, 468
For loops for pausing, 368
planning, 8
previewing, 487
progressive downloads, 346
search engine searchability, improving,

17
security for local/network playback, 469
testing, 487
video-editing applications, exporting

files from, 342-343
Flash Player, 2

debugging, 388
component, 332-333
frame-by-frame animation, testing, 225
installation, 3
magnification, changing, 487
masking and, 292
optimizing movies for, 468
printing from, 489
support for, 189
Version Detection, 475

Flash Project files, 14
Flash Remoting, 414
Flash Video Import Wizard, 323
Flash window, 30-31
FlashType, 176
flipping instances, 157
flowcharts, developing, 8
FLV files, 10, 325. See also Flash movies

exporting directly to, 346
Property Inspector, modifying video clips

in, 346
FLV (Flash Video) QuickTime Export plug-in,

342-343
FLVPlayback component, 332-333
folders. See also layers

Library assets, creating folders for, 12
overlapped root folder warning, 65
renaming (See naming/renaming)

Font Mapping dialog box, 177
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fonts
ActionScript text, setting for, 356
anti-aliasing, 176
attributes, 450
built-in Flash device fonts, 179
colors, changing, 166-167
deleting font mapping, 177
device fonts, setting, 178
embedded fonts, 178

symbols to embed font, creating, 
136-137

Find and Replace for, 186
mapping, 177
missing font information, 178
preferences, setting, 62
size, changing, 167
substitute fonts, selecting, 177
symbols to embed font, creating, 

136-137
TextArea component, adding, 400-401
type, changing, 166
warn on missing fonts, 64

For loops, 367
working with, 368

foreign languages. See languages
forms

components for building, 412
screens, creating, 496-497

45 degree angles, creating, 111
frame-based selection, 217
frame-by-frame animation, 211. See also

Onion Skinning
Controller, playing with, 224
description of, 212-213
exporting to Flash movie, 224
Flash Player, testing in, 225
keyframes, 211

clearing, 218
converting frames to, 216
copying, 220
creating, 214-215
deleting, 218-219
drag-and-drop, 221
editing, 220-221
empty keyframe, creating, 214-215
pasting, 220
removing content from, 214
selecting frames, 217

span of keyframe, increasing, 215
multiple frames, editing, 230
playing animation, 224-225
selecting frames, 217
simple animation, creating, 222-223

frame events, 364
frame rate, 16

motion tween, changing in, 256
Property Inspector, changing in, 16

frames. See also keyframes; scenes
copying frame sequence, 43
deleting, 43
inserting, 43
moving frame sequence, 43
selecting, 42
warn on inserting frames when import-

ing content, 64
Windows, setting in, 68

Free Transform tool
distorting shapes in, 120
instances, working on, 156-157
scale of object, changing, 118
for text, 175

Free Transform tool
envelope of shape, changing, 120
rotating object with, 119
skewing object with, 119

FreeHand, 187
importing options, 195
support for, 189

freehand text preferences, setting, 63
functions, using, 361
Future SplashPlayer, support for, 189

G
general preferences, setting, 60-61
Generator content, warn on reading, 64
geometric forms for shape tweening, 270
GIF files, 187

lossless compression with, 204
publishing movies, specifying options

when, 476-477
support for, 189

Global Handsets, 13, 498
Global Transform, 3D, 122-123
Glow effect, 240-241
Gradient Bevel effect, 240-241
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Gradient Transform tool, 121
for bitmap fills, 206-207

gradients
locking, 106
multi-color gradient, creating, 105
publishing movies, settings on, 478
quality, setting, 63
transforming gradient fills, 121

graphic symbols, 148-149
graphics, 73. See also bitmaps; drawing;

importing/exporting; layers; symbols;
vector graphics

bitmap graphics, 188
filter effects, applying, 240-241
grouping/ungrouping, 132
pasting objects between layers, 126-127
in slides, 494
symbols, converting to, 149
vector graphics, 188
warning preferences, setting, 65

greater than (>) statement, 370
greater than or equal to (>=) statement, 370
grids and guides. See motion tweening

creating guides, 91
guide layers, 40-41
locking/unlocking, 91
modifying, 92-93
showing/hiding, 90
snap to grid, locking/unlocking, 91
turning on/off, 91

grouping/ungrouping, 131
artwork, 132
Illustrator import preferences, 191
panels, 55
Photoshop import preferences, 192-193
stacking order, changing, 133

guides. See grids and guides

H
Hand tool, 47, 88
hardware requirements, 9
headers in XML documents, 435
help, 24-25
in Actions panel, 349

commands, 25
context-sensitive help, 376

Helvetica font, 176

built-in Flash device fonts for, 179
hidden layers. See publishing movies
hiding. See showing/hiding
hierarchical data, viewing, 426-427
highlight color preferences, setting, 162
hints. See also code hints

for shape tween, 280-281
Stroke hinting, 75

History file information, 472-473
History panel, 451

clearing, 453
command, saving steps as, 458-459
copying steps between documents, 

460-461
description of, 452
object level undo, working with, 462-463
opening/closing, 453
Options button, 452
repeating previous steps with, 452, 454
replaying steps with, 452, 453-454
undoing/redoing with, 452, 454-455
view, changing, 457

horizontal lines, creating, 111
HTML (Hypertext Markup Language). See

also publishing movies
CSS (Cascading Style Sheets), 183
keyboard shortcuts as HTML, 

exporting, 59
text rendered as, 180
XML compared, 435

HTTP/HTTPS security, 469

I
Illustrator, 187

converting layers options, 195
exporting Flash movies to, 490-491
file information, 472-473
import preferences, setting, 190-191
options for importing files, 194-195
Pen tool, 110
support for, 189

Import dialog box, 200
Import Script, 376
Import To Stage method, 196
importing/exporting. See also Flash movies;

publishing movies; video; specific file
formats

color palettes, importing, 98-99
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iimmppoorrttiinngg//eexxppoorrttiinngg  ((ccoonnttiinnuueedd))
different formats, exporting movie to,

490-491
file formats for, 189
Fireworks PNG files, 198-199
FLV format, exporting directly to, 346
frame-by-frame animation , 

exporting, 224
keyboard shortcuts as HTML, 

exporting, 59
media elements, 10
multiple files, importing, 200
profiles, 484-485
scripts, 376
sequence of files, importing, 200
sounds, 304-305
warning preferences, setting, 64-65

incompatibility warning preferences, 65
indents for text, setting, 173
inequality statement, 370
inheritance, 353
Ink Bottle tool, 102
input method, setting, 62
input text. See text
IPTC file information, 472-473
inserting file information, 472-473
Insert Target Path, 349
installation

preparation for, 2
standard application install, 3

instances
advanced color options, 160
behavior, changing, 144-145
blend, modifying, 159
breaking, 155
brightness, modifying, 158
for dynamic text, 180
flipping, 157
for graphic symbols, 148-149
for input text, 181
movie clip instances, 154
multiple instances, working on, 156
properties, changing, 443
rotation, modifying, 156-157
scale, modifying, 146-157
simultaneously modifying color and

transparency, 160
Stage, placing on, 142

swapping, 146-147
tint color, modifying, 158
transparency, modifying, 159, 160

Integrated Script window, 377
interlacing on publishing movies, 478
Inverse Kinematics, 283-288
invisible buttons, creating, 153

J
Japanese Handsets, 13
Java recordsets, 414
JavaScript, 14

commands, running, 459
History panel steps, viewing, 457

joins, 75
JPEG files, 10,187

publishing movies, specifying options
when, 480

Quality slider, dragging, 469
support for, 189

JSFL language, 51
justifying text, 172

K
kerning

adjusting, 168-169
Auto Kerning, setting, 169
preferences, setting, 62

keyboard controlling radio buttons, 398
keyboard shortcuts, 31

adding, 59
deleting, 58-59
HTML, exporting as, 59
open path, ending, 110
sets, creating, 58
Toolbar, identifying for, 51

keyframes, 42. See also frame-by-frame
animation; motion tweening; shape
tweening

copying, 43, 220
moving, 43

Kuler panel, 100-101

L
Label component, adding, 410-411
labels

Label component, adding, 410-411
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landscape orientation
Macintosh, setting in, 66
Windows, setting in, 68

languages
ActionScript language, setting, 356
character options, setting, 182
multi-language authoring, 181

Lasso tool
general preferences, setting, 61
with Magic Wand, 209
in polygon mode, 85
selecting with, 85

launching
Flash, 4-5
preferences on launch, setting, 60

Layer Properties dialog box, 40, 297
layers, 40. See also masks; motion 

tweening
copying layers or folder contents, 38-39
deleting layers/folders, 34-35
distributing graphics to, 129
expanding/collapsing folders, 38
guide layers, 40-41
height, changing, 40
Illustrator import preferences, 191
inactive layers, editing object on, 128
layer folder, creating, 34
locking/unlocking, 36, 40
moving layers/folders, 38
multiple layers, selecting, 35
naming/renaming, 34, 35, 40
new layers/folders, creating, 34
outlines, viewing contents as, 36-37
pasting objects between, 126-127
Photoshop import preferences, 192-193
pose, 283
properties, changing, 40
renaming, 34, 35, 40
selecting, 34-35
separate layers, placing objects on, 129
showing/hiding, 36, 40
types of, 40

layout
designing, 8-9
Windows, setting in, 68

leaf of Tree component, 426
left-aligning text, 172

less than (<) statement, 370
less than or equal to (<=) statement, 370
Library, 123. See also importing/exporting;

sounds; symbols; video
accessing options, 137
bitmaps, importing, 196-197
items, 350
opening, 134-135
organizing item, 136
other libraries, opening, 134-135
sample common libraries, 134-135
sounds, importing, 304-305

line segments
Selection tool, converting with, 115
Pen tool, creating with, 112

line spacing, setting, 173
Line tool, 75
linear gradients, 105
lines. See also line segments

connected lines, drawing, 130
45 degree angles, creating, 111
horizontal lines, creating, 111
recognize lines option, 130
vertical lines, creating, 111
width, changing, 75

linked layers. See masks
linking Library assets, 137
List component, adding, 408-409
Loader component, adding, 418-419
Lock Fill feature, 106
Lock icon, 36
locking/unlocking

gradients, 106
grids and guides, 91
layers, 36, 40
masks, 296

loops
creating, 367
exceptions, working with, 369
for graphic symbols, 148
sounds, looping, 317

lossless compression, 204
lossy compression, 204

M
Macintosh computers

keyboard commands on, 1
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MMaacciinnttoosshh  ccoommppuutteerrss  ((ccoonnttiinnuueedd))
launching Flash, 5
margins, setting, 66-67
page setup, working with, 66-67
printing documents, 70-71
projector, creating, 481
system requirements for, 2

MacPaint support, 189
Magic Wand bitmaps, editing, 208-209
magnification

Flash Player, changing in, 487
Magnifying Glass, 86-87

Magnifying Glass, 86-87
Main toolbar, 30-31

showing/hiding, 48
mapping MIDI device sounds, 500-501
margins

attributes, 450
Macintosh, setting in, 66-67
text margins, setting, 173
Windows, setting in, 68

markers. See Onion Skinning
mask layers, 40
masked layers, 40
masks, 289

activating, 295
adding layers to, 298
alpha masks, working with, 344-345
animating, 300-301
creating mask layers, 292-293
deleting

linked layers, 299
mask layers, 297

description of, 290-291
drawing masks, 294
editing, 296
linked layers

activating masks, 295
deleting, 299
order, changing, 298

Lock Layer column, 296
master symbols. See symbols
Maximize button, 19
maximizing/minimizing

in Actions panel, 349
with ActionScript Editor, 377
layer folders, 38

panels, 52-53
Tools panel, 50

media components, 391
Media Controller

advantages of using, 336
for frame-by-frame animation, 224
for streaming video, 335
working with, 336-337

Media Display
for streaming video, 335
working with, 334-335

media elements, 10
Media Playback, 334-335
Media Player for streaming video, 334-335
MenuBar component, adding, 404-405
menus, 31

MenuBar component, adding, 404-405
Merge Drawing, 61, 73

converting to Object Drawing shape, 74
message

Web Services (WSDL) documents and,
434

in XML documents, 435
Metadata, 354

file information, 472-473
methods, 348, 350-351. See also

ActionScripts; parameters
applying, 354-355

MIDI device sounds, mapping, 500-501
Minimize button, 19
minimizing. See maximizing/minimizing
miter joins, 75
Mobile SWF file information, 472-473
mobile devices. See cell phones; PDAs 

(personal data assistants)
monitor resolution requirements, 9
Motion Editor, 238-243
motion tweening,

adding color effects and filters, 240-241
adding frames to tween, 254
adjusting, motion, 237
creating, 

classic, 245
motion, 236

color effects, adding, classic, 262
copying tween, 252-253
deleting

frames from tween, 254-255
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keyframes, classic, 258-259
ease in/out properties

customizing, classic, 266
setting, classic, 251

edit path, motion, 243
frame properties, classic, 247
frame rate, changing, 256
instance properties, 247
keyframes

adding, 249, 258
deleting, classic, 258-259
moving, 249
work with, motion, 242

length of tween, changing, 254-255
Motion Editor, 238-243
motion guides

animating along, classic, 264
creating, classic, 263
orienting objects along, classic, 265

pasting tween, 252-253
presets, motion tween, 234-235
properties

ease properties, setting, classic, 251
frame and instance properties com-

pared, 247
pasting properties, 253
setting, classic, 250-251

reversing frames, 257
rotation, changing, classic, 260-261
scale

changing, classic, 260
rotate and scale, working with, 119

simple motion tween, creating, classic,
248-249

smoother animation, adding frames for,
255

target object, 231
understanding,

classic, 232-233, 246
differences, 232
motion, 231, 232-233

working with, classic, 246
mouse

events, 362, 363
resizing windows with, 19

movie clips, 154. See also components
clip events, 365-366
controlling video through, 330-331

dot syntax, applying, 358
Illustrator import preferences, 190-191
9-slice scaling, using, 161
Photoshop import preferences, 192-193
placing video in, 327
scaling, 161
ScrollPanel component for, 424-425
Start/Stop Dragging Movie clip

Behaviors, 372
symbols, 154
Timeline, referencing to, 329
Window component, adding, 428-429

Movie Explorer, debugging with, 378-379
moving

document windows, 19
files, 21
frame sequence, 43
keyframes, 43
layers/folders, 38
Tools panel, 50

MPG/MPEG files, 325
MP3 files, 10

compression, 319
streaming MP3 file, loading, 314-315

multi-language authoring, 181
multi-purposing, 466
music. See sounds

N
named anchor on scene, setting, 61
naming/renaming

Command menu, deleting name from,
458

command names, deleting, 458-459
debugging, file names and, 374
folders, 21
keyboard shortcut sets, 58
layers, 34, 35, 40
with Movie Explorer, 378
panel sets, 57
scenes, 44-45
smart conventions, using, 374-375

navigating
in help topics, 24
planning for, 10-11

.Net recordsets, 414
nodes of Tree component, 426
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normal layers, 40
Normal selection mode, 81
number data, 360
NumericStepper component, adding, 420-

421

O
object data, 360
objects

working with ActionScript 3.0, 352-353
Object Drawing, 61, 73

warning preferences, 65
working with, 74

objects, 348. See also ActionScripts; 
properties

tracking per-object changes, 462-463
On2 VP6 codec, 346
onClipEvent(), 365, 366
Onion Skinning, 211

activating, 226
manually setting markers, 228
Modify Onion Markers Window, setting

markers in, 229
outlines, using, 227

online activation requirement, 3
opaque setting for publishing movies, 477
Open dialog box, 21
open path, Pen tool for, 110
opening

existing documents, 14-15
History panel, 453
launching, opening documents on, 5
panels, 52
Scene panel, 44

Options menu, 349
OR conditional statement, 370
orientation. See also Landscape orientation;

Portrait orientation
bitmap fill orientation, changing, 206-207
text orientation, 170

Outline icon, 36
outlines of layer contents, 36-37
outside editors

ActionScript code, editing, 354
bitmaps, editing, 202-203

Oval tool, 78
ovals, creating, 61, 70
Over state for buttons, 150

overlapped root folder warning, 65

P
page setup

in Macintosh, 66-67
Windows, working in, 68-69

Page Setup dialog box
in Macintosh, 66-67
in Windows, 68-69

page size settings, 68
Paint Behind mode, 107
Paint Bucket

fills, editing, 103
fills with, 98
sensitivity, setting, 103

Paint Fills mode, 107
Paint Inside mode, 107
Paint Normal mode, 107
Paint Selection mode, 107
Paintbrush tool, 98, 107
panel sets

creating, 56
deleting, 57
displaying, 56
renaming, 57

Panel windows, 6
panels, 30

auto-collapsing, 60
docking/undocking, 54
expanding/collapsing, 52
grouping/ungrouping, 55
opening/closing, 52

Panels Options menu, 53
paper size settings, 66-67
parameters

authoring parameters, 440, 441
editing, 442-443
working with, 441

Parameters tab, Component Inspector, 391
parameters to functions, passing, 296
password parameters, 442
Paste Frames command, 220-221
Paste In Center, 126-127
Paste In Place, 126-127
Pasteboard. See Work Area
pasting

Clipboard, pasting images in, 201
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keyframes, 220
layers, objects between, 126-127
motion tweens, 252-253

paths
bitmap, preserving paths on importing,

202
in debugging, 374
Illustrator import preferences, 191

pausing movie with For loops, 368
PDAs (personal data assistants)

content for PDA, creating, 498
deployment of Flash movies to, 501

PDF files, 187
importing options, 194
Macintosh documents, printing, 71

Pen tool, 
closed path, creating, 111
curves, drawing, 112-113
deleting anchor points with, 111
description of, 111
open path, creating, 110
options, 130
S-curves, creating, 113
selection with, 81
Show Precise Cursors option, 112

Pencil tool, 
in Smooth mode, 76-77
in Straighten mode, 76

perspective angle, 3D, 124
photo compression, 204
Photo Slideshows, 13
Photoshop, 187

converting layers options, 195
file import preferences, setting, 192-193
options for importing files, 194-195
pasting images from, 201
support for, 189

PICT files
exporting movies to, 490-491
settings, 63
support for, 189

Pin Script, 349
pinning multiple scripts, 377
pixels, 188

document, setting for, 16-17
planning

debugging and, 375
movies, 8

project plans, creation, 8-9
Play Once for graphic symbols, 148
playhead, 42
playing

frame-by-frame animation, 224-225
sounds, 312-313

PNG files, 187
importing, 198-199
lossless compression with, 204
publishing movies, specifying options

when, 478-479
support for, 189

polygons
Lasso tool for, 85
with Polystar tool, 80

polymorphism, 353
Polystar tool, 80
port types, Web Services (WSDL) docu-

ments and, 434
portrait orientation

Macintosh, setting in, 66
Windows, setting in, 68

pose layer, 283
preferences

ActionScript preferences, setting, 356
Clipboard preferences, setting, 63
general preferences, setting, 60-61
text preferences, setting, 62
warning preferences, setting, 64-65

Preferences dialog box. See drawing
preloaders, 418

ProgressBar component as, 422
previewing, 11

Flash movies, 487
Macintosh documents, 71

Primitive mode, 61
primitive rectangles/ovals, creating, 61, 79
Primitive shapes, 78
printers

Macintosh, setting properties in, 67
Windows, setting properties in, 69

printing. See also margins
with ActionScripts, 489
from Flash Player, 489
general preferences, setting, 61
help topics, 25
Macintosh documents, 70-71
Windows documents, 72
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product updates. See updates
profiles. See publishing movies
ProgressBar component, adding, 422-423
progressive downloads, 346
Project panel, 502-505
projector document, creating, 481
projects

creating and managing, 504-505
general preferences, setting, 61, 505
plans, creating, 8-9
testing, 506

properties, 350-351. See also documents;
motion tweening; parameters

applying, 354-355
instance properties, changing, 443
layer properties, changing, 40
of movie clip symbols, 154
shape tween properties, setting, 278
viewing, 385

Property Inspector, 6, 30-31. See also
behaviors; motion tweening

background color, changing, 16
bitmaps, swapping, 197
Color popup, 158
fill colors, changing, 96-97
Flash FLV video clips, modifying, 346
frame rate, changing, 16
kerning, adjusting, 168
motion tweens, adjusting, classic, 250
stroke color, changing, 98
text, rotating, 170

Publish Preview command, 487
Publish Settings dialog box, 340, 346, 465

security options, 469
publishing movies, 11, 465

Adobe Air, 470-471
Bandwidth Profiler, working with, 488
considerations for, 466
duplicating profiles, 486
editing profile properties, 483
GIF options, specifying, 476-477
hidden layers

exporting, 469
viewing, 37

HTML files, 11
options, specifying, 474-475

importing/exporting
different formats, exporting movie to,

490-491
hidden layers, exporting, 469
profiles, 484-485
protecting from import, 468

JPEG options, specifying, 480
modifying publish settings, 467
options, specifying, 468-469
Photoshop import preferences, 193
PNG options, specifying, 478-479
previewing movies, 487
profiles

creating, 482
duplicating, 486
editing properties of, 483
importing/exporting, 484-485

projector document, creating, 481
QuickTime video, Flash document as,

340-341
sound documents, 318-319
testing movies, 487

purpose of project, determining, 8
PushButton type, 151

Q
QuickTime Export Settings dialog box, 

338-339
QuickTime Image support, 189
QuickTime/QuickTime Pro

exporting movies to, 338-339, 490-491
FLV Export Plug-in support, 342
publishing Flash document as, 340-341
version requirements, 2
video file support, 325

quitting Flash, 28
Quiz, 13

R
radial gradients, 105
RadioButton, 151

component, adding, 398-399
RAM requirements, 9
raw data file information, 472-473
raw sounds, 319
readability, anti-aliasing for, 176
recordsets, DataGrid component for, 414
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Rectangle Settings dialog box, 79
Rectangle tool, 78-79

rounded rectangle, drawing, 79
rectangles

Selection tool, selecting with, 84
primitive rectangles, creating, 61, 79

redoing. See undoing/redoing
registration point, creating, 139
renaming. See naming/renaming
repeating previous steps with History

panel, 452, 454
Replace. See Find and Replace
replaying steps with History panel, 452,

453-454
resizing

bitmap fills, 206-207
bitmap graphics, 188
document windows, 19
fonts, 166
gradient fills, 121
text boxes, 165
Timeline display, 32

Restore Down button, 19
Reverse Frames command, 257
RGB colors

instances, modifying colors of, 160
values, entering, 98

right-aligning text, 172
Rotate Text button, 171
rotation

with Free Transform tool, 119
gradient fills, 121
instance, modifying rotation of, 156-157
motion tween, changing during, classic,

260-261
Rotation tool, 3D, 122-123
of text, 170-171
working with, 119

round joins, 75
rounded rectangle, drawing, 79
rulers. See also grids and guides

showing/hiding, 89
unit of measure, specifying, 17, 89

S
S-curves, creating, 113
sample rate for sounds, 319

sans serif fonts, 176
built-in Flash device fonts for, 179

Save As dialog box
folders, renaming, 21
formats for files, 22

saving. See also documents
Snap Align defaults, 95
undo, saving documents after, 455
warning preferences, setting, 64

scale. See also motion tweening
Free Transform tool for changing, 118
instance, modifying scale of, 156-157
Macintosh, setting in, 66-67
movie clips, 161
9-slice scaling, using, 161
Windows, setting in, 68
working with, 119

Scene button, 46
Scene panel, 44
scenes

adding scenes, 44
deleting, 45
edit, selecting scene to, 47
named anchor on scene, setting, 61
naming/renaming, 44-45
reordering, 45
selecting, 44-45

Schema tab, Component Inspector, 391,
440, 448, 443. See also schemas

schemas
description of, 448
modifying, 449

schematic flowcharts, 8
script, developing, 8
Script Assist, 376, 414
Script Navigator, 349, 377
Script pane, 349
scroll bars, 424-425
scrolling

DataGrid component with, 414
text, creating, 181

ScrollPanel component, adding, 424-425
scrubbing, 224
search engines, 17
searching

with Find and Replace, 186
for help information, 25
with spell-checking, 184
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security for local/network playback, 469
Selection tool, 81

connected stroke segments, selecting, 83
fills, selecting, 84
line segments, converting, 115
multiple stroke segments, selecting, 83
rectangles, selecting, 84
shapes, modifying, 114
strokes, selecting, 82-83

selecting
with Selection tool, 82-83
contact-sensitive selection, setting, 61
frames, 42, 217
with Lasso tool, 85
layers, 34-35
scenes, 44-45
span based selection, 61
text, 172

Send to Back/Send Backward, 133
sending a document, e-mail, 507
serial number for installation, 3
serif fonts, built-in Flash device fonts for,

179
shape hints, 280-281
shape tweening, 267

alpha, changing, 279
ball animation

combining tweening and movement
in, 276-277

creating, 274-275
blending properties, setting, 278
colors, changing, 279
combining tweening and movement in

ball animation, 276-277
creating shape tween form, 270-271
deleting keyframes, 272-273
hints, setting, 280-281
keyframes

adding, 272
deleting, 272-273

properties, setting, 278
working with, 268-269

shapes. See also masks; shape tweening
Selection tool, modifying with, 114
breaking text fields into, 174-175
distorting shapes, 120
envelope of shape, changing, 120
optimizing, 77

recognize shapes option, 130
with Rectangle tool, 78-79
rough shapes, converting, 76
Stage, creating shapes on, 414
Subselection tool, modifying with,

116-117
shared audio libraries, working with, 308-

309
Sharing My Screen, 508
shortcuts. See also keyboard shortcuts

Macintosh, shortcut to Flash on, 5
Show Precise Cursors, 112
showing/hiding

Edit bar, 46
grids and guides, 90
layers, 36, 40
Main toolbar, 48
rulers, 89
Tools panel, 50
Welcome screen, 4

Silicon Graphics Image support, 189
Single Frame for graphic symbols, 148
site maps, 8
size reports, generating, 468
skewing with Free Transform tool, 119
Skinning component, 324
skins, 324
slide presentations, creating, 494-495
Slide Screen feature, 494-495
smooth curves. See curves
Smooth mode, Pencil tool in, 76-77
Snap Align, 94-95
snap to grid, locking/unlocking, 91
Snap to Object command, 95
SOAP (Simple Object Access Protocol), 436
Sorensen codec, 346
sound card requirements, 9
Soundbooth, 303, 321
SoundComplete event, 312
sounds, 303

with ActionScript 3.0, 310-311
with ActionScript behaviors, 310-311
with behaviors, 310-311
bit rate for, 319
editing, 320, 321
effects, 317
embedded audio files, 305
events, triggering, 312
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external library, adding audio with, 
306-307

Find and Replace for, 186
importing, 304-305
Library

external library, adding audio with,
306-307

importing sounds to, 304-305
shared audio libraries, working with,

308-309
Timeline, adding sounds to, 306-307

looping sounds, 317
MIDI device sounds, mapping, 500-501
MP3 file, loading, 314-315
playing sounds, 312-313
publishing sound documents, 318-319
quality, changing, 319
shared audio libraries, working with,

308-309
in slides, 494
Soundbooth, 321
stopping sounds, 312-313

all sounds, 315
streaming MP3 file, loading, 314-315
sync sounds

animation, adding to, 305
Timeline, adding to, 316

Timeline
animation, adding sounds to, 305
Library, transferring file from, 306-307
sync sounds, adding, 316

timing of, 320
types, 303
zooming on, 320

span-based selection, 61, 217
Spanish text, displaying, 181
Spray Brush tool, 108
speech files, 319
spell-checking, 184-185
Spelling Setup dialog box, 184-185
squares, creating, 79
stacking order, changing, 133
Stage, 7, 29, 30-31. See also frames; import-

ing/exporting; layers; sounds; Work
Area

bitmap to Stage, importing, 196
components, adding, 391
dimensions, setting, 17

Hand tool, moving with, 47, 88
shapes directly on stage, creating, 414
Snap Align, 94-95
video files on, 326
view size, changing, 47
zooming specific area on, 86-87

Start menu, 15
Start/Stop Dragging Movie clip Behaviors,

372
startup preferences, customizing, 4
static media, 10
static text. See text
stepping through code, 387
steps. See History panel
stopping sounds. See sounds
Straighten mode, Pencil tool in, 76
streaming MP3 file, loading, 314-315
streaming video. See video
string data, 360
Stroke hinting, 75
strokes. See also lines

colors, changing, 98
Eyedropper tool, editing with, 104
Ink Bottle tool, editing with, 102

Subselection tool, 81
anchor points and vectors, editing, 110
corner points to curve points, 

converting, 116-117
curve points to corner points, 

converting, 116-117
shapes, modifying, 116-117

supplies for Macintosh printing, 71
Swap dialog box, 146-147
Swap Symbol feature, 146-147
swapping bitmaps, 197
Swatches panel

fill colors, changing, 97
for shape tween, 279
stroke color, changing, 98
text colors, changing, 167

.swc files. See components

.swf files. See Flash movies
switching between documents, 18
Symbol button, 46
symbols. See also buttons; instances;

motion tweening; movie clips
animations to symbol, converting, 139
attributes, 450
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behavior, changing, 144
duplicating during swap, 147
editing

entering/exiting editing mode, 
140-141

master symbols, editing, 142-143
existing artwork to symbol, converting,

138
exiting editing mode, 141
Find and Replace for, 186
font symbols, creating, 136-137
graphic symbols, 148-149
IK animations, 283-287
master symbols

breaking instances from, 155
editing, 142-143

new symbols creating, 138
registration point, creating, 139
warning preferences, setting, 65

syntax. See also dot syntax
ActionScript 3.0, 353
checking, 349
indentation, 356

syntax-coloring
in debugging, 377
schemes, 356

system requirements, 2

T
tab size, setting, 356
telephones. See also cell phones

activation requirement, 3
templates. See also documents

for mobile device content, 498
saving documents as, 23

10-second rule, 488
Test Movie, 211. See also masks; motion

tweening; shape tweening
debugging with, 380-382
general preferences, setting, 60

testing. See also debugging
debugging and, 375
Flash movies, 487
frame-by-frame animation, 225
projects, 506

text, 153. See also characters; fonts; kerning
aligning paragraph text, 172
anti-aliasing, 176
bitmap text, 176
breaking text fields, 174-175
colors, changing, 167
ComboBox component, adding, 394-395
CSS (Cascading Style Sheets), working

with, 183
dynamic text

character options for, 182
creating, 180

freehand text preferences, setting, 63
Illustrator, importing from, 190
input text, 163

character options for, 182
component, adding, 392-393
creating, 180-181
parameters, editing, 442-443

line spacing, setting, 173
margins, setting, 173
Photoshop import preferences, 192-193
preferences, setting, 62
rotation of, 170-171
scrolling text, creating, 181
selecting, 172
shapes, breaking text fields into, 174-175
single column of vertical text, creating,

170
spell-checking, 184-185
static text, 163

creating, 164
TextArea component, adding, 400-401
tracking, adjusting, 168
transforming, 175
vertical text, 170-171

block, creating, 171
options, setting, 62

text boxes, creating, 165
text files, loading, 165
Text tool, 164
TextArea component, adding, 400-401
TextInput component, adding, 392-393
TGA file support, 189
3D Space

Global Transform, 122-123
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perspective angle, 124
Rotation, tool, 122-123
vanishing point, 125
Translation, tool, 122

TIFF file support, 189
Timeline, 7, 30-31. See also effects; frames;

sounds; video
changing display, 32
elements, adding motion to, 11
frames display, changing, 32-33
movie clips, referencing, 329
resizing display, 32
sync sounds to animation, adding, 305

timing rule, 488
tint color

instance tint color, modifying, 158
motion tween, adding to, 240

toggle buttons, adding, 402-403
Toolbar, 6, 29, 30-31. See also Main toolbar

customizing, Tools panel, 50-51
expanding/collapsing, 49, 50
moving, 50
showing/hiding, 48-50, 52-53 

Toolbox, 349
Tools, creating, 51
Tools panel. SeeToolbar
tooltip preferences, 61
trace actions, protecting from, 468
Trace Bitmap dialog box, 210
tracing bitmaps, 210
tracking, adjusting, 168
Transformation panel, 156-157
transformation point, working with, 118
transition settings, 478
Translation tool, 3D, 122-123
transparency

instance transparency, modifying, 159,
160

publishing movies, setting on, 477
Tree component, adding, 426-427
turning on/off

grids and guides, 91
Work Area visibility, 88

tweening. See motion tweening; shape
tweening

typewriter fonts, 179

U
UI components, connecting, 444
Undo command, 454

saving documents after using, 455
undoing/redoing

general preferences, setting, 60
History panel for, 452, 454-455
number of levels, changing, 48
object level undo, working with, 462-463
scene deletions, 45
text transformations, 175
Transform effects, 158

unlocking. See locking/unlocking
Up state for buttons, 150
updates

online updates/support, 26-27
previous Flash versions, 3
registering to receive, 26

URLs changes warning, 64
user interface components, 391

V
variable names

for dynamic text, 180
for input text, 181

vanishing point, 3D, 125
variables, 348. See also ActionScripts

viewing, 383
Watch list, adding to, 384

vector graphics, 73, 188
tracing bitmaps to creating, 210

vectors, 73
Version Cue

enabling, 61
Version Detection, 475
vertical lines, creating, 111
vertical text. See text
video, 293. See also Media Display; movie

clips; QuickTime/QuickTime Pro
with behaviors, 328-329
components, 391
controlling from Timeline, 328-329
file formats for, 325
Find and Replace for, 186
FLV format, exporting clips into, 346
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with Media Player, 334-335
in slides, 494
Stage, moving file on, 326
streaming video

with Media Controller, 336-337
with Media Display, 334-335
with Media Player, 334-335

Video Import wizard, using, 324-325
video card requirements, 9
Video Encoder, 342-343
Video Import wizard, using, 324-325
views and viewing

document properties, 16
History panel, changing view in, 457
Stage, changing view size of, 46

W
warning preferences, setting, 64-65
Watch list variables, adding, 384
WAV files, exporting movies to, 490-491
Web Services (WSDL), 431

description of, 434
Web 216 color palette, 477
WebServicesConnector, 431, 436-437
Welcome screen, 4, 6
While loops, 367

working with, 369
width of gradient fills, changing, 121
Window component, adding, 428-429
Windows Media File (WMV), 325
Windows Metafile (WMF)

exporting movies to, 490-491
support for, 189

Windows PCs
keyboard commands on, 1
launching Flash, 4
printing documents, 72
projector, creating, 481
system requirements for, 2

word wrapping, 376
Work Area, 88

storing graphics in, 126
Workspaces. See Panel Set.

X
XML (Extensible Markup Language), 181

CSS (Cascading Style Sheets), 183
description of, 435
ECMAScript, 349
HTML compared, 435
projects as, 504

XMLConnector component, 431, 438-439
XMP file information, 472-473

Z
Zoom button, 19
zooming

on bitmap images, 196
changing magnification area, 87
with Magnifying Glass, 86-87
on sounds, 320
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